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1 OUTLINE OF WAZE TRAVEL SPEED DASHBOARD  

1.1 Introduction 

On 3 November 2016, MMDA and Waze (under Alphabet [Google]) signed a memorandum 

of understanding (MOU) for a data-sharing partnership. Waze has been implementing a 

free reciprocal traffic information program, named “Connected Citizens Program” or CCP 

(it is now called Waze for Cities, https://www.waze.com/wazeforcities/), and as part of this 

program, it is working on a sharing initiative with MMDA. 

Based on Waze data, there are 2.4 million active Wazers in the Philippines, who use the 

app for an average of 110 minutes per day. This number is about seven times more than 

the average of Wazers worldwide, which is about 15 minutes per day. While Wazers are on 

the app, GNSS location information acquired by each Wazer's smartphone is sent to the 

Waze server, indicating that a large amount of data is being collected by Waze. 

In terms of data provision, instead of MMDA providing information on traffic restrictions, 

road construction, major traffic events, and traffic accident to Waze, Waze provides 

anonymized real-time travel speeds where traffic jams occur and traffic events that are 

collected from Wazers. 

However, the utilization of Waze data had not progressed on the MMDA side. Hence, the 

JICA Project Team (JPT) deemed it necessary to acquire the data and create a database, 

i.e., a travel speed dashboard, to understand the temporal-spatial continuum of travel 

speeds on the road network in Metro Manila. The JPT developed a travel speed dashboard 

and used this database to identify bottlenecks causing traffic congestion. MMDA can use it 

for a before-and-after evaluation of the implementation of congestion countermeasures and 

traffic policies. 

 
Source: WAZE  

Figure 1.1:  Connected Citizens Program 

  

https://www.waze.com/wazeforcities/
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1.2 Concept of Travel Speed Dashboard 

The JPT developed Travel Speed Dashboard based on the following concepts: 

(i) Store travel speed data from Waze; 

(ii) Visualize the travel speed situation on the road network in Metro Manila from a bird's-

eye view;  

(iii) Can search and retrieve data based on some criteria (e.g., year, month, day of the week, 

speed level, road type) and visualize the travel speed situation; and 

(iv) Can output data to create a time-space diagram to identify bottlenecks in each corridor. 

1.3 Waze Data Specification 

Data from Waze is provided in XML or JSON format via the Waze application programming 

interface (API), and real-time data is updated every 2 minutes. 

A feed reader module has already been developed for MMDA by Waze’s partner company 

Thinking Machines, which allows users to regularly retrieve and record data in a database 

via the Waze API.  

Table 1.1:  Event Information and Travel Speed Data provided by Waze 1 

 
Source: Waze 
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Table 1.2:  Event Information and Travel Speed Data provided by Waze 2 

 
Source: Waze 
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1.4 Development of Pipeline for Aggregation  

JPT developed a “pipeline” to generate data for the dashboard based on Waze data. The 

pipeline is shown in Figure 1.2, where the data from “Waze-Traffic-Data” is stored in the 

“Thinking Machine Waze Data Warehouse” every two minutes, and the data in the “JICA-

MMDA Waze Data Warehouse” is stored once a month.  

Waze data updates traffic information every two minutes. However, the dashboard is not 

intended to visualize real-time traffic conditions. After a certain amount of traffic data has 

been accumulated, it can be aggregated and analyzed to provide a bird's-eye view of the 

traffic condition on a road network that is continuous in time and space. Therefore, the 

dashboard is designed to be updated once a month based on Waze data. 

Figure 1.3 shows the full data stream in the data warehouse. The blue boxes represent the 

pipeline tasks, while the yellow boxes represent the output tables generated by that specific 

pipeline task. It gets raw data from Waze, stores it in the jams table, then undergoes a 

series of data transformations before getting to the final road link lookup table. 

 
Source: JPT 

Figure 1.2:  Diagram of the Data Platform  
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Source: JPT 

Figure 1.3:  Data Flow for the Travel Speed Dashboard 
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1.5 Development of Travel Speed Dashboard 

The Travel speed dashboard has functions of the visualization dashboard can be broadly 

divided into two: (1) color-coded display of travel speeds, and (2) color-coded display of the 

percentage of time for a given travel speed in a given period. 

(a) Color-coded Display of Travel Speeds: The dashboard calculates the travel speeds 

on each road link based on the difference between the travel speed data obtained from 

Waze data and free-flow speed data and displays them in different colors. 

(b) Color-coded Display of the Percentage of Time for a Given Travel Speed in a 

Given Time: In contrast, this function specifies, for example, that the percentage of 

travel speeds below 30km/h was 30% or more on a weekday in January 2021. The 

system then extracts and displays the road sections where the travel speed has been 

decreasing (going below 30km/h) for a long time (for more than 30% of the specified 

period). This function shows the more serious areas, or bottlenecks, where the 

slowdown continues for a long time. 

The color-coding of travel speeds is based on the conditions in Table 1.3. 

Table 1.3:  Color Coding based on Travel Speed 

 
Source: JPT 

The dashboard visualizes jams at the road link level given the following parameters: 

(a) Percentage of Time below a Given Speed: Only displays the road links that meet the 

percent of occurrence. 

(b) Speed: Only displays the road links that are selected in the range. 

(c) Worst Road Links based on Percentage of Time: Narrows down the search to worst 

road links in terms of jams or delays. 

(d) Road Links with Speeds below a Given Speed: Only displays the road links that are 

selected in a range. 

(e) Time of Day: Selected time from the 24-hour data. 

(f) Day of Week: Selected day/s of the week. 

(g) Month: Selected month/s of the year. 
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(h) Road Type: Selected road type (expressway, Class A1, Class A2, Class B, Class C, 

Class D, and Others). 

(i) Direction: d0 (eastbound/northbound) and d1 (westbound and southbound). 

In addition, the dashboard has a function to visualize and display the aggregate results, as 

shown in Figure 1.4.  

It also has a function to output the data being displayed as CSV data and to output CSV 

data to create a time-space diagram. After updating the map, the attributes of the entire 

road network and the space-time table of the circumferential and radial roads may be 

exported as CSV. It is also possible to output a CSV file to create a time-space diagram of 

bottlenecks in each corridor, as shown in Table 1.4.
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Source: JPT 

Figure 1.4:  Waze Dashboard App 
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Table 1.4:  Exported Data to Create a Time-Space Diagram 

 
Source: JPT 
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1.6 Utilization of the Dashboard 

By using the developed Travel Speed Dashboard, the following use cases are expected:  

(i) Understanding of the traffic situation in Metro Manila from a bird’s-eye views 

(ii) Identification of potential traffic bottlenecks based on quantitative analysis; 

(iii) Analysis of traffic congestion at the corridor level;  

(iv) Evaluation of the effectiveness of countermeasures by comparing between before and 

after implementation; and 

(v) Analysis of the impact of severe incidents and events. 

The above utilization can be referred to as TR4 Identification of Traffic Bottlenecks and      

Monitoring.   

Figure 1.5 shows a sample of the use case of analyzing congestion using a time-space 

diagram. The vertical axis is time, and the horizontal axis is distance. The redder the color, 

the lower the speed. Based on the visualization, when and where congestion starts and 

how far it extends can be determined. 

 
Source: JPT 

Figure 1.5:  Sample of a Time-Space Diagram to Analyze Congestion 

Figure 1.6 compares the travel speed data between March 2019 before the pandemic 

curtailed public mobility and March 2020 when Metro Manila was placed under ECQ. Travel 

speeds on EDSA in 2019 were low at less than 20km/h, but 2020 figures showed around 

60km/h.  

Using these diagrams, the situation before and after significant events/incidents can be 

compared and the impact on traffic flow can be analyzed. MMDA can use these when 

considering interventions before such events happen. In addition, the effectiveness and 

impact of traffic management interventions on traffic flow implemented in conjunction with 

the opening of new roads and railway infrastructures can be verified. 
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22.34     21.75     21.79     21.95     22.28     24.53     26.26     27.33     23.97     27.07     27.40     28.22     28.24     29.67     32.18     34.04     34.04     33.16     30.76     30.23     26.30     25.50     25.47     27.61     33.32     34.01     

21.88     21.16     21.11     21.07     21.21     22.27     23.10     23.38     20.48     22.82     23.00     23.53     23.37     25.12     28.80     32.04     32.04     31.12     30.46     30.47     27.11     26.44     26.23     28.78     33.55     34.18     

24.46     23.35     23.26     23.17     23.29     24.26     24.62     24.49     21.31     23.88     23.99     24.36     24.33     26.21     29.98     32.67     32.67     32.02     30.60     30.17     27.26     26.62     26.45     29.38     33.94     33.59     

23.78     22.83     22.73     22.64     22.76     23.75     23.80     23.57     20.63     23.10     23.26     23.73     23.73     25.71     29.82     33.19     33.19     32.69     31.23     30.79     28.47     27.65     27.53     29.69     34.13     33.91     

21.02     20.54     20.54     20.46     20.56     21.31     21.34     21.18     19.51     20.93     21.04     21.38     21.38     23.18     27.91     31.38     31.38     31.30     31.25     31.05     28.85     28.17     28.15     30.76     34.14     34.29     

18.68     18.31     18.31     18.32     18.40     19.04     19.17     19.24     17.79     19.17     19.32     19.83     19.82     21.59     26.27     29.58     29.58     29.22     28.43     28.17     25.73     24.98     24.61     27.79     33.91     34.14     

17.09     16.67     16.67     16.66     16.71     17.32     17.43     17.53     16.23     17.56     17.64     18.06     18.09     19.55     23.66     27.17     27.18     26.94     26.13     25.60     21.86     20.96     20.89     25.01     33.38     33.48     

15.79     15.40     15.41     15.42     15.46     15.87     15.90     16.00     14.65     16.19     16.29     16.62     16.64     17.64     20.57     24.50     24.50     24.23     24.32     24.59     21.30     20.36     20.35     24.86     32.37     32.27     

15.08     14.68     14.71     14.75     14.74     15.18     15.22     15.25     13.97     15.36     15.38     15.51     15.55     16.72     18.86     21.49     21.50     21.47     22.12     22.33     19.68     19.03     18.87     25.01     31.38     30.90     

13.88     13.57     13.58     13.61     13.67     14.02     14.06     14.09     13.27     14.18     14.26     14.39     14.37     15.20     16.93     18.65     18.66     18.62     19.84     19.85     17.82     17.47     17.54     23.32     30.39     30.22     

13.70     13.37     13.40     13.42     13.42     13.74     13.77     13.78     12.73     13.89     13.99     14.25     14.21     15.09     16.83     19.00     19.01     18.72     19.18     19.82     17.78     17.39     17.57     23.09     31.48     30.25     

14.59     14.18     14.17     14.17     14.19     14.59     14.61     14.63     13.36     14.70     14.74     14.84     14.83     15.88     17.95     20.65     20.65     19.98     19.08     19.06     17.62     17.37     17.63     23.39     31.02     29.97     

14.67     14.22     14.20     14.21     14.25     14.66     14.66     14.65     13.41     14.66     14.73     14.90     14.83     15.76     17.77     19.92     19.92     18.86     17.61     17.45     15.82     15.43     15.58     21.64     31.61     30.99     

15.10     14.74     14.72     14.72     14.73     15.09     15.11     15.11     13.92     15.20     15.26     15.43     15.43     16.34     17.67     19.61     19.61     18.99     17.91     17.89     16.55     16.28     16.59     23.35     32.38     31.93     

15.93     15.52     15.54     15.55     15.56     15.96     15.90     15.91     14.54     16.05     16.12     16.32     16.27     17.25     19.00     22.04     22.04     21.20     20.33     20.31     18.36     18.04     18.28     24.46     33.31     32.76     

16.38     15.98     15.98     15.97     15.97     16.26     16.25     16.28     15.23     16.32     16.35     16.45     16.43     17.43     19.41     23.22     23.22     22.56     21.10     20.79     18.97     18.64     18.81     23.98     33.89     33.33     

17.07     16.70     16.68     16.67     16.68     16.97     16.96     16.94     15.75     16.91     16.94     17.03     16.98     17.77     19.61     23.74     23.74     23.14     21.85     21.58     18.88     18.32     18.46     24.01     34.06     33.77     

16.56     16.16     16.17     16.17     16.21     16.59     16.58     16.54     15.13     16.58     16.62     16.67     16.64     17.60     19.27     23.18     23.19     22.44     21.72     21.57     18.80     18.21     18.32     23.75     33.72     33.04     

15.63     15.20     15.19     15.20     15.25     15.63     15.60     15.60     14.14     15.75     15.82     15.87     15.84     16.53     17.72     21.59     21.60     20.93     19.93     19.72     16.89     16.42     16.68     22.97     32.28     31.57     

14.55     14.20     14.20     14.21     14.25     14.59     14.57     14.57     13.43     14.71     14.76     14.92     14.94     15.70     16.82     20.79     20.79     20.46     20.23     20.54     19.04     18.83     19.21     25.01     30.95     30.20     

14.04     13.61     13.63     13.65     13.68     14.08     14.09     14.07     12.54     14.15     14.26     14.54     14.55     15.17     16.64     21.08     21.08     21.29     22.33     23.09     21.22     20.93     21.12     26.54     32.09     30.48     

13.62     13.24     13.24     13.25     13.27     13.61     13.60     13.61     12.41     13.75     13.81     13.99     14.03     14.82     16.55     21.22     21.22     21.06     21.52     22.84     21.20     21.04     21.61     26.60     31.55     30.61     
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Source: JPT 

Figure 1.6:  Travel Speeds on EDSA Before and During the Pandemic

March 2019
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2 DESIGN AND TECHNICAL DOCUMENTATION 

2.1 Architecture of Platform 

(1) Architecture Diagram 

Figure 2.1 shows how data flows through the platform. The specific components are as 

follows: 

(a) Data Source: Waze-traffic data is fetched via an API request to the GeoRSS API. 

(b) App Engine Cron Job: makes an API request to Thinking Machines' internal Flask 

Web Service every two (2) minutes which orchestrates the fetching of Waze-traffic data 

and the automation of loading to a Google Cloud Storage bucket and BigQuery datasets. 

(c) Raw Waze Dataset: contains the tables for the raw Waze-traffic data i.e., irregularities, 

jams, and alerts. 

(d) Dagster: runs the road links speed calculation steps on the Waze-traffic data from the 

Raw Waze Dataset. 

(e) Instance Schedule: boots up the Compute Engine instance hosting the Dagster 

instance every first day of the month. Booting up the Compute Engine instance will run 

the road links speed calculation pipeline. 

(f) Processed Waze Dataset: contains the Big Query output tables processed from road 

links speed calculation executed by the Dagster instance; tables in this dataset are 

ready for consumption in the JICA Dashboard Web App. 

(g) Cloud Run: will host the Dashboard Web App which can query and display the 

processed Waze data from the Processed Waze Dataset in a map view. 

 
Source: JPT 

Figure 2.1:  Diagram of the Data Platform  

(2) Google Cloud Platform 

This travel speed database and dashboard used could service “Google Could Platform”. 

(a) A Suite of Cloud Computing Services that runs on the same infrastructure that 

Google uses internally for its end-user products (ex. Google Search, Gmail, and 

YouTube) 
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(b) Wide Range of Services: Computing, Storage, Big Data, Machine Learning, 

Networking, Developer Tools, and Management tools 

(c) Project Name: MMDA-waze 

(3) GCP Services  

Listed in the chart below are the GCP services used for the project. Each of these services 

will be described in detail, and the role it plays in the project’s overall architecture. 

Table 2.1:  GCP Services 

Service Description Project Purpose 

Cloud Storage  File storage web service for storing 
and accessing data on the GCP 
infrastructure  

 Host files generated by services within 
the Google Cloud Platform, audit logs, 
and Terraform backend 

Big Query  Serverless data warehouse that 
enables scalable analysis over 
petabytes of data via ANSI SQL 

 Store raw Waze-traffic data, and run 
queries for the Waze Speed Calculation  

Compute Engine  Scalable and configurable virtual 
machines 

 Run the Dagster Waze Speed 
Calculation pipeline monthly 

Cloud Build  Serverless CI/CD platform for 
building, testing, and deploying 
software 

 Automate the building and pushing of 
the Dagster pipeline image to the 
Container Registry upon merging of 
change requests to the pipeline code in 
the GitHub repository 

Cloud Identity and Access 
Management (IAM) 

 Identity management solution for 
accesses to GCP's resources 

 Control and limit access to the different 
services running on the Google Cloud 
Platform project 

Container Registry  Repository for storing, managing, 
and accessing the GCP project's 
Docker images 

 Contain the images of the pipeline and 
dashboard code 

Cloud Run  Serverless platform for developing 
and deploying highly scalable 
containerized applications 

 Hosts the container for the JICA 
dashboard web app 

Source: JPT 

(4) Cloud Storage (GCS) 

Table 2.2:  Cloud Storage used for the Project 

Bucket Name Description 

*Artifacts.mmda-waze.appspot Bucket used for storing Cloud Run builds artifacts 
MMDA-waze_cloudbuild Bucket used by Cloud Run for staging build objects 
MMDA-waze-logsink Bucket used for the GCP project logs 
MMDA-waze-terraform Bucket for storing Terraform state, Terraform automates the 

management of the GCP project's resources through code 
Source: JPT 

(5) Compute Engine (GCE) 

Below is a list of all the GCE instances in this project and their respective purposes: 

Table 2.3:  GCE Instances in the Project 

VM Name Purpose 

Dagster-monthly VM instance that hosts the monthly Waze Speed 
Calculation pipeline for production use, started every first 
day of the month and turned off at the last minute of the day. 

Dagster-monthly-dev VM instance that hosts the Waze Speed Calculation 
pipeline for development use. 
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VM Name Purpose 
Dagster-historical VM instance that hosts the historical Waze Speed 

Calculation pipeline for production use. 
Dagster-historical-dev VM instance that hosts the historical Waze Speed 

Calculation pipeline for development use. 
Source: JPT 

(a) Instance Schedules 

Below is a list of all the instance schedules responsible for scheduling when to turn on and 

off the GCE instances in the project: 

Table 2.4:  Instance Schedules 

Instance Schedule Name Purpose 

Monthly-speed-calculation-
schedule 

Starts the dagster VM every 12:00 AM Manila Time Zone on the first 
day of the month, and stops at 11:59 PM the same day. 

Daily-speed-calculation-
schedule 

Starts the dagster-dev VM every 12:00 AM Manila Time Zone every 
day, and stops it at 6:00 AM the same day. Can be disabled during 
the non-development time to save costs. 

Source: JPT 

(6) Access and Security (IAM): Users and Service Accounts 

End-user access and application access through service accounts are managed through 

Cloud Identity and Access Management (Cloud IAM.)   Each user, group of users, or 

service account is assigned a role(s) to determine the level of access to GCP resources.  

A role is a collection of permissions that is granted to the users and determines the level of 

access to GCP resources.  Permissions cannot be assigned directly to an individual user 

or group of users.  Roles, instead of permissions, are granted to the users. 

(a) Service Accounts 

To run code in GCP, service accounts are required and assigned to applications. Each 

application can have as many service accounts as needed to represent the different logical 

components.   

Below is a table that details the service accounts, purpose, and assigned roles: 

Table 2.5:  Service Account Details 

Service Account Name Purpose Roles 

waze-pipeline-service-
account@mmda-
waze.iam.gserviceaccount.com 

 Service account used by the Waze 
Speed Calculation pipeline; also 
assigned to the Compute Engine 
instance hosting the pipeline  

 BigQuery Data Editor 
 BigQuery Job User 
 BigQuery Read Session User 
 Secret Manager Secret Accessor 
 Storage Admin 

waze-74407@appspot. 
gserviceaccount.com 

 Service account for enabling the transfer 
of raw Waze-traffic data from Thinking 
Machines' internal `waze-174407` GCP 
project to the `mmda-waze` project 

 BigQuery Data Editor 
 BigQuery Job User 

mmda-waze-jica-
dashboard@mmda-
waze.iam.gserviceaccount.com 

 Service account used by the JICA 
Dashboard web app in the dev 
environment deployed on Cloud Run 

 BigQuery Data Viewer 
 BigQuery Job User 
 BigQuery Read Session User 

mmda-waze-jica-dashboard-
prod@mmda-
waze.iam.gserviceaccount.com 

 Service account used by the JICA 
Dashboard web app in the production 
environment deployed on Cloud Run 

 BigQuery Data Viewer 
 BigQuery Job User 
 BigQuery Read Session User 

218567230177@cloudbuild. 
gserviceaccount.com 

 Service account used by Cloud Build 
when automating the building of the 
pipeline image and pushing it to the 

 Cloud Build Service Account 



The Project for Comprehensive Traffic Management Plan for Metro Manila 
TECHNICAL REPORT NO. 3: WAZE DATA DASHBOARD AND USER MANUAL 

 

2-4 

Service Account Name Purpose Roles 

Container Registry 

jica-waze-pipeline-
bqup@mmda-
waze.iam.gserviceaccount.com 

 Service account used by bqup for 
exporting the project's BigQuery 
structure and source code  

 BigQuery Metadata Viewer 

terraform-service-
account@mmda-
waze.iam.gserviceaccount.com 

 Service account used for managing the 
project's GCP resources through 
Terraform 

 Cloud Build Editor 
 Cloud SQL Admin 
 Compute Admin 
 Compute Network Admin 
 Service Account Admin 
 Service Account User 
 Project IAM Admin 
 Storage Object Admin 

Source: JPT 

(7) Google Groups 

Table 2.6:  Google Groups Purposes 

Service Account Name Purpose Roles 

mmda-waze-
devs@thinkingmachin.es 

 Google Group for developers and maintainers of 
the project  

 Owner 

jica-mmda-waze-
clients@thinkingmachin.es 

 Provides view access to all the GCP Project 
resources to the stakeholders 

 Viewer 

jica-mmda-waze-clients-bq-
user@thinkingmachin.es 

 Enables viewing of BigQuery data and metadata, 
and the usage of BigQuery jobs for analysis 

BigQuery Data Viewer 
 BigQuery Job User 

Source: JPT 

(a) Networking 

Table 2.7:  Network used for the Project 

Network Subnetwork Region IP Address Ranges Gateways 

Dagster-network DAGSTER-network-subnetwork us-central1 10.0.0.0/16 10.0.0.1 
Source: JPT 

(8) BigQuery 

BigQuery is an enterprise data warehouse that enables super-fast SQL queries using the 

processing power of Google's infrastructure. 

The BigQuery (BQ) Project Structure follows Thinking Machine’s (TM) project structure 

standards for data warehouses. These standards ensure a consistent high-quality structure 

and process to manage the BQ tables and views in the project.  

(a) Cloud Run 

For hosting the JICA Dashboard web application we run services in Cloud Run. We have 

separate services for the phase 1 and phase 2 versions of the web application listed below: 

Table 2.8:  Services Run in Cloud Run 

Service Name Description 

mmda-waze-jica-
dashboard-dev 

Cloud Run service for the JICA dashboard web app for 
development purposes 

mmda-waze-jica-
dashboard-prod 

Cloud Run service for the JICA dashboard web app for 
development 

mmda-waze-jica-
dashboard-phase-1-prod 

Cloud Run service for the Phase 1 JICA dashboard web 
app for production use 

Source: JPT 

https://cloud.google.com/bigquery/docs/introduction
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2.2 Aggregation Method 

This chapter discusses the most crucial variables and terminologies involved in the 

computations. Shown below, is a table of summary of each variable, their descriptions, and 

what each one looks like in the data warehouse. Furthermore, each variable, along with 

visual examples, is further expounded upon in the succeeding subchapter. 

(1) Variables  

Table 2.9:  Variables used in the Computations 

Variable Description Sample Data 

Road Type  Numeric code for the type of road 
where the jam occurred 

 1 - street 
 17 - private road 

Roadlink  <100m road segment splits  Lawton Ave _s0_i1_m0 
 A. Mabini Ave _s0_i0_m2 

Freeflow Speed  speeds along roads when and where 
there is no traffic (in m/s) 

 25.84 
 33.71 

Jammed Speed  average speed in a jam from Waze 
data (in m/s) 

 20.81 
 29.56 

Direction  pertains to the direction of the jam  d0 
 d1 

Source: JPT 

(a) Jams 

Before defining the variables, it is crucial to define what a jam is as this is the main 

foundation of the calculations. According to Waze, a jam is recorded when the average 

speed among a certain number of cars on the road falls below 20% of the usual speed 

along that road. This “usual speed”, or what we call free flow speed, is the average speed 

of a car traveling when there is no heavy traffic (e.g. speeds of cars early in the morning). 

(b) Road Type 

Road types are numerical values that help us categorize the kind of road being considered. 

Shown below are the current values from the Waze documentation. For analysts, knowing 

the type of road they are dealing with will help them to have more accurate estimates of 

speed and other metrics. 

Table 2.10:  Road Type Classification 

Road Number Road Type 

1 Expressway 

2 Class A1 

3 Class A2 

4 Class B 

5 Class C 

6 Class D 

11 Others 
      Source: JPT 

(c) Road Links 

In Waze data, roads are lengths and lines defined by geographical coordinates. Roads are 

defined by linestrings, which are a connected series of line segments, often represented by 

a collection of longitude and latitude coordinates. The image below shows an example 

linestring, which, when transformed with geographic functions in the data warehouse, 

translates to the Batasan-San Mateo Road in Quezon City.  
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Source: JPT 

Figure 2.2:  Linestring Translation of Batasan-San Mateo 

Road links are just smaller road segments with lengths less than 100m. The reason for 

splitting these roads into smaller segments is to further improve the accuracy and 

consistency of speed calculations on these roads, as jams are highly dependent on 

intersections. The way the team has split roads into road links involves two processes: the 

naming and the calculation processes. 

(a) How Road Links were Named 

Table 2.11:  Naming of Road Links 

Steps Road Link Names 

1, Starting with the original street name Batasan-San Mateo Rd 

2, This is then differentiated from other 
streets also named 10th Ave 

Batasan-San Mateo Rd_s0 

3, Splits by intersections with other streets Batasan-San Mateo Rd _s0_i0, 
Batasan-San Mateo Rd _s0_i1, etc. 

4, Split into <100m road links Batasan-San Mateo Rd _s0_i0_m0, 
Batasan-San Mateo Rd_s0_i0_m1, etc. 

Source: JPT 

The first process is divided into four steps as shown in the table above. To further 

understand this, we take our previous linestring for example. We have a starting linestring 

for a road named Batasan-San Mateo Rd. This entire road length is further classified 

differently from those who have the same street name, resulting in naming conventions like 

Batasan-San Mateo Rd_s0 and Batasan-San Mateo Rd_s1 (Batasan-San Mateo Rd Street 

0, Street 1). The third step further splits these unique streets by intersections, resulting in 

names like Batasan-San Mateo Rd_s0_i0 and Batasan-San Mateo Rd_s0_i1 (Batasan-San 

Mateo Rd Street 0 Intersection 0, Street 0 Intersection 1). Lastly, these are split into road 

link segments smaller than 100m, resulting in names like Batasan-San Mateo 

Rd_s0_i0_m0, Batasan-San Mateo Rd_s0_i0_m1. 

(b) How Road Links were Split 
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Table 2.12:  Splitting the Road Links 

Steps 

1, Obtain the unique coordinates for each road in Waze from 
linestrings 

2, Split the road into smaller segments based on its 
intersections with other roads 

3, If there are any segments longer than 100m, split these into 
even smaller segments of length (original length)/100 each 

Source: JPT 

This second process is responsible for trimming the long linestrings into road link segments 

of less than 100m. For example, the raw linestring of Batasan-San Mateo Rd is more than 

100m, thus, this will be continuously split using the steps as mentioned in the table until we 

satisfy our threshold.  

Eventually, we arrive at segments that satisfy the conditions, as shown below. 

 
Source: JPT 

Figure 2.3:  Trimmed Down Linestring of Batasan–San Mateo 

Shown below is an example of how each linestring looks like in the data warehouse. 

 
Source: JPT 

Figure 2.4: Linetstring in Data Warehouse 
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(c) Freeflow Speed 

One of the issues with Waze data is that it does not provide travel speeds in free-flow 

conditions, as Waze is primarily intended to display congested sections. To solve this issue, 

the travel speed during free flow is calculated from “jammed speeds”, “delay travel time 

between free flow and jammed condition,” and “jammed length” values in the Waze data. 

The specific calculation method is described below. 

Free-flow speeds (in meters per second) are along roads when there is no traffic. Free-flow 

speed is a prerequisite to understanding the formula used for jammed speeds, as these are 

used to infer travel times along the unjammed parts of roads. This formula computes free-

flow speeds: 

 

Where: length_jam = length of jam according to Waze (in meters) 

speed_jam = average travel speed along with the jam (in meters per second) 

delay_jam = difference between the in-jam delayed travel time and the ideal 
free-flow travel time (in seconds)  

For any given date and road link, this is applied in the following manner: 

(i) Get the jams that occurred on the road link for that day and the past days; 

(ii) Compute the free-flow speed using the formula; 

(iii) Take the median free-flow speed among those jams. 

Freeflow speeds (in meters per second) are the speeds along roads when there is no traffic. 

Freeflow speed is a prerequisite to understanding the formula that the team used for 

jammed speeds, as these are used to infer travel times along the unjammed parts of roads. 

Freeflow speeds were computed by this formula: 

 

 
Where: 

length_jam = length of jam according to Waze (in meters) 

speed_jam = average travel speed along the jam (in meters per second) 

delay_jam = difference between the in-jam delayed travel time and the 

ideal free-flow travel time (in seconds)  

For any given date and road link, this is applied in the following manner: 

(i) Get the jams that occurred on the road link for that day and the past days 

(ii) Compute the free-flow speed using the formula 

(iii) Take the median free-flow speed among those jams 

(d) Jammed Speed 

Jammed speed (in meters per second) is a metric that is provided by Waze data. It is the 

average speed of vehicles on a congested road. The jammed speed formula that the JPT 
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used was based on the inference from free-flowing speeds of vehicles on the road links. 

The formula for jammed speed is shown below.  

 

Where: length_jam = length of jam accdg. to Waze (in meters) 

length_freeflow = length of jam not occupied by length_jam (in seconds) 

traveltime_jam = length_jam / jam speed (in meters) 

traveltime_freeflow = length_freeflow / free-flow speed (in seconds) 

(e) Direction 

Direction pertains to the direction of a traffic flow on a road link. This is another important 

variable to be aware of, as shown in the final dashboard. 

There are only two values for the road link directions: d0 and d1. Jams with d0 pertain to 

road links with traffic flows closer to either true East or true North or those that point towards 

Quadrant 1 of the XY plane. On the other hand, jams with d1 pertain to road links with traffic 

flows closer to either true West or true South or those that point towards Quadrant 3 of the 

XY plane.  

Table 2.13:  Definition of Directions 

 
Source: JPT 

To further understand how direction is calculated, Figure 2.5 shows a specific example. If 

there exists a jam (the red arrow in the figure), and it’s pointing towards Quadrant 1, leaning 

more towards the northern angle, following the conditions above, the jam direction is closer 

to the true North/true East rather than the true South/true West. Therefore, the direction of 

this jam is d0. 

 
Source: JPT 

Figure 2.5:  Setting Directions of Traffic Flows 

This variable will help distinguish the speeds between two opposing traffic flows on the 

same road link.  

(2) Buffer Zones  

Buffer zones will be set up to handle changes in Waze Road Data due to inaccurate GPS 

by the app. This does not guarantee that the changing Waze road data will always be 
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captured, but it increases the change of capture. The buffer zones are still able to 

distinguish overlapping road data due to overpasses or flyovers.  

The size of the buffer zone will depend on road type and size. The same buffer zone range 

will apply every month and year. If the coordinates of the road change per run and these 

are not captured by the buffer zones, they will not be captured by the data. 

(3) Corridor Maps and Visualizations 

The road links per corridor were developed by JPT.   

The maps show alignments of circumferential and radial roads and can be queried on 

BigQuery GeoViz. 

Query: 

SELECT ST_GEOGFROMTEXT(coords) as linestring 

FROM `mmda-waze.waze_lookups.202110_corridors_v2` 
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Source: JPT 

Figure 2.6:  Alignments of Circumferential and Radial Roads in Metro Manila 
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2.3 Data  

This section covers the data source used in the Waze Speed Calculation pipeline and the 

JICA Dashboard web app, BigQuery datasets, for storage of both raw and processed Waze-

traffic data, frequency of data ingestion and processing, and the detailed flow of data from 

source to final tables produced. 

(1) Data Flow 

A better view of the flowchart can be seen in the Whimsical link here. This is the full data 

stream for the CTMP Project in the data warehouse. The blue boxes represent the pipeline 

tasks while the yellow boxes represent the output tables generated by that specific pipeline 

task. It gets raw data from Waze, stores it in the jams table, then undergoes a series of data 

transformations before we arrive at the final road link lookup table. 

https://whimsical.com/jica-data-model-v3-4FWD5fPvPutfFQMC6m6js2
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   Source: JPT 

Figure 2.7:  Data Flowchart 
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(2) BigQuery Datasets 

Table 2.14:  Dataset Details 

Dataset Name Details 

waze_lookups Dataset for the processed and aggregated Waze-traffic data in production 
use; tables sourced by the JICA Dashboard web application in the prod 
environment are stored here; this dataset is updated monthly 

waze_lookoups_dev Dataset for the processed and aggregated Waze-traffic data in 
development use; tables sourced by the JICA Dashboard web application 
in the dev environment are stored here; use this dataset when testing 
changes introduced to the pipeline code before deploying to production 

waze_traffic Dataset for the raw Waze-traffic data: jams, alerts, irregularities; this 
dataset is updated every 2 minutes; for production use 

waze_traffic_historical Dataset for the raw Waze-traffic data: jams, alerts, irregularities; a 
historical copy up to a certain date but not appended every 2 minutes 
unlike `waze_traffic` 

phase_1_web_app Dataset for the processed Waze data ready for dashboard consumption; 
for production use 

Source: JPT 

(3) Data Dictionary and Data Processing 

(a) Data Dictionary and Data Processing Sheet 

Table 2.15:  Data Dictionary and Data Processing Sheet 

 
  

Project NameDataset Name Table Name Fields Value Description Notes Shared/Internal
mmda-waze waze_lookups roadlinks_v6 street_unique STRING Name string of the roadlink in  <street_name>_s<i>_i<j>_m<k> format where: street_name - refers to raw street name s<i> - ith roadlink with the same street name i<j> - jth intersection of the roadlink m<k> - kth <100 meter split of the roadlink Used for prod/live dashboards Shared

WKT LINESTRING

Linestring representation of the roadlink; 

contains the roadlink's coordinates that can be 

visualized using certain geographic functions Used for prod/live dashboards Shared

Used for prod/live dashboards

mmda-waze waze_lookups _roadlink_lookup roadlink_id INTEGER

Integer ID of the roadlink; unique identifier of 

each roadlink Used for prod/live dashboards Shared

roadType INTEGER

Integer representation of the road type;

refer to either the Waze-traffic spec or JICA's 

documentation; used for more accurate 

estimates of vehicle speeds on that road type Used for prod/live dashboards Shared

street_sim STRING Formatted name string of the roadlink Used for prod/live dashboards Shared

coords

GEOGRAPH

Y

Linestring representation of the roadlink; 

contains the roadlink's coordinates that can be 

visualized using certain geographic functions Used for prod/live dashboards Shared

angle FLOAT Angle of roadlink in degrees Used for prod/live dashboards Shared

bq_roadlink_length FLOAT Length of the roadlink in meters Used for prod/live dashboards Shared

buffered_6m

GEOGRAPH

Y

Polygon representation of the roadlink with 6.5m 

buffers on each side Used for prod/live dashboards Shared

mmda-waze waze_lookups street_segment_lookup street STRING

Name string of the roadlink in 

<street_name>_s<i> format

where:

street_name - refers to raw street name

s<i> - ith roadlink with the same street name Used for prod/live dashboards Shared

coords STRING

Polygon/multilinestring representation of the 

street segment 

coordinates in string Used for prod/live dashboards Shared

bearing STRING

The angle of the roadlink with respect to the 

horizontal X axis Used for prod/live dashboards Shared

direction_horizontal STRING Horizontal direction of the street E.g. E, W Used for prod/live dashboards Shared

direction_vertical STRING Vertical direction of the street E.g. N, S Used for prod/live dashboards Shared

direction_road STRING Direction of the road E.g. E, W, N, S Used for prod/live dashboards Shared

mmda-waze waze_lookups _freeflow_speeds roadlink_id INTEGER Integer ID of the roadlink Used for prod/live dashboards Shared

direction_jam STRING Direction of the jam E.g. N, S, E, W Used for prod/live dashboards Shared

year INTEGER Year when jam occured Used for prod/live dashboards Shared

month INTEGER

Integer representation of month when jam 

occured (e.g 0 = January, 1 = February, etc) Used for prod/live dashboards Shared

number_of_observations INTEGER

Number of vehicle samples that were added to 

get this average freeflow speed value in that 

specific time frame Used for prod/live dashboards Shared

freeflow_speed FLOAT

Speeds of the vehicles without traffic (in meters 

per second) Used for prod/live dashboards Shared

https://docs.google.com/spreadsheets/d/1M1R9QUuaMC7pFAL-Gwto_JUMWPWWexnqpkYIcTRhZ7g/edit#gid=1199105118


The Project for Comprehensive Traffic Management Plan for Metro Manila 
TECHNICAL REPORT NO. 3: WAZE DATA DASHBOARD AND USER MANUAL 

 

2-15 

 

 
 

Project NameDataset Name Table Name Fields Value Description Notes Shared/Internal

mmda-waze waze_lookups _aggregates_per_minute time TIMESTAMP Timestamp of jam recorded Used for prod/live dashboards Shared

roadlink_id INTEGER Integer ID of the roadlink Used for prod/live dashboards Shared

direction_jam STRING Direction of the jam captured by the roadlink Used for prod/live dashboards Shared

rl_length FLOAT Length of the roadlink in meters Used for prod/live dashboards Shared

ixn_total_length FLOAT Total length of intersection in meters Used for prod/live dashboards Shared

ixn_length_multiplier FLOAT

Integer multiplier of how much the intersection 

will grow based on aggregates Used for prod/live dashboards Shared

freeflow_speed FLOAT Speeds of the vehicles without traffic Used for prod/live dashboards Shared

jammed_time FLOAT Duration of jam in seconds Used for prod/live dashboards Shared

mmda-waze waze_lookups __webapp_table_<date> roadlink_id INTEGER Integer ID of the roadlink Used for prod/live dashboards Shared

direction_jam STRING Direction of the jam E.g. N, S, E, W Used for prod/live dashboards Shared

day DATE Date of when the jam has occured Used for prod/live dashboards Shared

hour INTEGER

Total number of hours that a jam occured on 

that roadlink in a specific timeframe Used for prod/live dashboards Shared

minute_bucket INTEGER

Pertains to which minute time frame the jam was 

captured (segmented between 0 minutes, 20 

minutes, and 40 minute time-windows between 

full hours); Has unique values of 0, 20, 40 only Used for prod/live dashboards Shared

ave_speed FLOAT

average travel speed along the jam (in meters 

per second) Used for prod/live dashboards Shared

mmda-waze waze_lookups __webapp_table_old_format street_unique STRING

Formatted ame string of the roadlink in 

<street_name>_s<i>_i<j>_m<k> format

where:

street_name - refers to raw street name

s<i> - ith roadlink with the same street name

i<j> - jth intersection of the roadlink

m<k> - kth <100 meter split of the roadlink Used for prod/live dashboards Shared

speed FLOAT

freeflow speed of vehicles in that jam (meters 

per second) Used for prod/live dashboards Shared

time INTEGER Used for prod/live dashboards Shared

day INTEGER Integer value to day of the month Used for prod/live dashboards Shared

month INTEGER

Integer value of month of the year (e.g. 0 = 

January, 1 = February) Used for prod/live dashboards Shared

year INTEGER Year of when the jam occured Used for prod/live dashboards Shared

date DATE Timestamp of when the jam occured Used for prod/live dashboards Shared

roadtype INTEGER

Integer representation of the road type of the 

roadlink; refer to either the Waze-traffic spec or 

JICA's documentation Used for prod/live dashboards Shared

direction INTEGER

Has only two values 0 and 1, which pertains to 

d0 and d1. 

d0 are for jams closer to the direction of either 

the true East or true North. 

d1 for jams closer to the direction of either the 

true West or true South Used for prod/live dashboards Shared

mmda-waze waze_lookups _average_ff_per_rl_dir street_unique STRING

Formatted ame string of the roadlink in 

<street_name>_s<i>_i<j>_m<k> format

where:

street_name - refers to raw street name

s<i> - ith roadlink with the same street name

i<j> - jth intersection of the roadlink

m<k> - kth <100 meter split of the roadlink Used for prod/live dashboards Shared

roadlink_id INTEGER Integer ID of the roadlink Used for prod/live dashboards Shared

direction INTEGER

Has only two values 0 and 1, which pertains to 

d0 and d1. 

d0 are for jams closer to the direction of either 

the true East or true North. 

d1 for jams closer to the direction of either the 

true West or true South Used for prod/live dashboards Shared

freeflow_speed FLOAT Calculated freeflow speed in meters per second Used for prod/live dashboards Shared

observations INTEGER

Number of datapoints used to calculate the 

average freeflow speed Used for prod/live dashboards Shared
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Project NameDataset Name Table Name Fields Value Description Notes Shared/Internal

N/A N/A N/A ff_d0 INTEGER

Alias from _average_ff_per_rl_dir

If the value for the direction column above is 

0, this refers to the freeflow speed average 

for that row's roadlink. 

Is the value of freeflow speeds that follow 

the direction of the roadlinks. Used for prod/live dashboards Shared

ff_d1 INTEGER

Alias from _average_ff_per_rl_dir

If the value for the direction column above is 

1, this refers to the freeflow speed average 

for that row's roadlink. 

Is the value of freeflow speeds that follow 

the opposite direction of the roadlinks. Used for prod/live dashboards Shared

freq_d0 INTEGER

Alias from _average_ff_per_rl_dir

If the value for the direction column above is 

0, this refers to the total number of 

observations (under the observation 

column). 

Total number of datapoints used to calculate 

ff_d0 values; more datapoints make the ff_d0 

values much more significant and accurate Used for prod/live dashboards Shared

freq_d1 INTEGER

Alias from _average_ff_per_rl_dir

If the value for the direction column above is 

1, this refers to the total number of 

observations (under the observation 

column). 

Total number of datapoints used to calculate 

ff_d1 values; more datapoints make the ff_d1 

values much more significant and accurate Used for prod/live dashboards Shared

waze-174407

jica_2021_<suffix

>

raw_jams_spatiotemporal_fil

ter speed FLOAT Jam speed in meters per second

Used for dev/testing only, 

intermediate table used for 

computations Internal

street STRING Name string of the street specific to that city

Used for dev/testing only, 

intermediate table used for 

computations Internal

city STRING Name string of the city where the jam occurred

Used for dev/testing only, 

intermediate table used for 

computations Internal

length INTEGER Jam length in meters

Used for dev/testing only, 

intermediate table used for 

computations Internal

roadType INTEGER

Integer representation of the road type;

refer to either the Waze-traffic spec or JICA's 

documentation

Used for dev/testing only, 

intermediate table used for 

computations Internal

delay INTEGER

difference between the in-jam delayed travel 

time and the ideal freeflow travel time (in 

seconds) 

Used for dev/testing only, 

intermediate table used for 

computations Internal

jamTime TIMESTAMP Time the jam occurred

Used for dev/testing only, 

intermediate table used for 

computations Internal

coords STRING

Linestring representation of where the jam 

occurred

Used for dev/testing only, 

intermediate table used for 

computations Internal

waze-174407

jica_2021_<suffix

> _distinct_jam_coordinates jam_id INTEGER Integer ID of the jam

Used for dev/testing only, 

intermediate table used for 

computations Internal

coords STRING

Linestring representation of the jam coords in 

string

Used for dev/testing only, 

intermediate table used for 

computations Internal

street STRING

Name string of the street where the jam 

occurred

Used for dev/testing only, 

intermediate table used for 

computations Internal

roadType INTEGER Road type of the street where the jam occurred

Used for dev/testing only, 

intermediate table used for 

computations Internal

num_jams INTEGER Number of times the jam occurred in the table

Used for dev/testing only, 

intermediate table used for 

computations Internal

bq_jam_length FLOAT Length of the jam linestring in meters

Used for dev/testing only, 

intermediate table used for 

computations Internal

waze-174407

jica_2021_<suffix

> _all_jams jam_id INTEGER

Integer ID of the jam referenced in the 

_distinct_jam_coordinates

Used for dev/testing only, 

intermediate table used for 

computations Internal

time TIMESTAMP Start time of the jam

Used for dev/testing only, 

intermediate table used for 

computations Internal

jammed_speed FLOAT Jammed speed in meters per second

Used for dev/testing only, 

intermediate table used for 

computations Internal

freeflow_speed FLOAT Calculated freeflow speed in meters per second

Used for dev/testing only, 

intermediate table used for 

computations Internal

waze-174407

jica_2021_<suffix

> possible_jam_rl_ixn jam_id INTEGER

Integer ID of the jam referenced in the 

_distinct_jam_coordinates

Used for dev/testing only, 

intermediate table used for 

computations Internal

street_jam STRING

Name string of the street where the jam 

occurred

Used for dev/testing only, 

intermediate table used for 

computations Internal

street_sim STRING

Formatted name string of the street where jam 

occurred 

<street_jam>_s<i>_i<j>_m<k> format

where:

street_name - refers to street where jam 

occured

s<i> - ith roadlink with the same street name

i<j> - jth intersection of the roadlink

m<k> - kth <100 meter split of the roadlink 

Used for dev/testing only, 

intermediate table used for 

computations Internal
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Source: JPT 

 

 
 
  

Project NameDataset Name Table Name Fields Value Description Notes Shared/Internal

waze-174407

jica_2021_<suffix

>

jam_roadlink_intersection_lo

okup_with_mls jam_id INTEGER

Integer ID of the jam referenced in the 

_distinct_jam_coordinates

Used for dev/testing only, 

intermediate table used for 

computations Internal

jam_street STRING

Name string of the street where the jam 

occurred

Used for dev/testing only, 

intermediate table used for 

computations Internal

street_sim STRING

Formatted name string of the street where jam 

occurred 

<jam_street>_s<i>_i<j>_m<k> format

where:

street_name - refers to street where jam 

occured

s<i> - ith roadlink with the same street name

i<j> - jth intersection of the roadlink

m<k> - kth <100 meter split of the roadlink 

Used for dev/testing only, 

intermediate table used for 

computations Internal

roadlink_id INTEGER Integer ID of the roadlink that captured the jam

Used for dev/testing only, 

intermediate table used for 

computations Internal

intersection

GEOGRAPH

Y

Linestring representation of the intersection 

within the roadlink

Used for dev/testing only, 

intermediate table used for 

computations Internal

rl_length FLOAT Roadlink length in meters

Used for dev/testing only, 

intermediate table used for 

computations Internal

ixn_length FLOAT Intersection length in meters

Used for dev/testing only, 

intermediate table used for 

computations Internal

waze-174407

jica_2021_<suffix

>

jam_roadlink_intersection_e

xploded_with_perpendicular

s jam_id INTEGER

Integer ID of the jam referenced in the 

_distinct_jam_coordinates

Used for dev/testing only, 

intermediate table used for 

computations Internal

roadlink_id INTEGER Integer ID of the roadlink that captured the jam

Used for dev/testing only, 

intermediate table used for 

computations Internal

intersection STRING

Linestring representation of intersection 

coordinates in string

Used for dev/testing only, 

intermediate table used for 

computations Internal

waze-174407

jica_2021_<suffix

> jam_roadlink_intersections ixn_id INTEGER Integer ID of the intersection from the roadlink

Used for dev/testing only, 

intermediate table used for 

computations Internal

intersection STRING

Linestring representation of the intersection 

coordinates

Used for dev/testing only, 

intermediate table used for 

computations Internal

ixn_length FLOAT Length of the intersection in meters

Used for dev/testing only, 

intermediate table used for 

computations Internal

angle FLOAT Angle of the intersection in degrees

Used for dev/testing only, 

intermediate table used for 

computations Internal

ixn_firstpoint STRING

Linestring coordinates of starting point of the 

intersection on the map; connect to endpoint to 

draw intersection

Used for dev/testing only, 

intermediate table used for 

computations Internal

ixn_endpoint STRING

Linestring coordinates of last point of the 

intersection on the map; connect to start point to 

draw intersection

Used for dev/testing only, 

intermediate table used for 

computations Internal

waze-174407

jica_2021_<suffix

>

jam_roadlink_intersection_di

r roadlink_id INTEGER Integer ID of the roadlink

Used for dev/testing only, 

intermediate table used for 

computations Internal

ixn_id INTEGER Integer ID of the intersection from the roadlink

Used for dev/testing only, 

intermediate table used for 

computations Internal

direction_flow BOOLEAN

Boolean value to dictate if jam flows with or 

against predicted traffic direction

Used for dev/testing only, 

intermediate table used for 

computations Internal

waze-174407

jica_2021_<suffix

>

_jam_roadlink_intersection_l

ookup jam_id INTEGER Integer ID of the jam

Used for dev/testing only, 

intermediate table used for 

computations Internal

roadlink_id INTEGER Integer ID of the roadlink that captured the jam

Used for dev/testing only, 

intermediate table used for 

computations Internal

capped_intersection_leng

th FLOAT

Length of the intersection in the roadlink in 

meters

Used for dev/testing only, 

intermediate table used for 

computations Internal

direction_flow BOOLEAN

Boolean value to dictate if jam flows with or 

against predicted traffic direction

Used for dev/testing only, 

intermediate table used for 

computations Internal

direction_jam STRING Direction of the jam E.g. N, S, E, W

Used for dev/testing only, 

intermediate table used for 

computations Internal
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(b) Computations 

 
Source: JPT 

Figure 2.8:  Computation Flowchart 

Details: 

(i) Lookup Table is fixed on its location data across each run. (i.e. 150: Padre Burgos E 

_s0_i0_m0, primary roads will always have the same location coordinates) Based on 

2018 to 2020 data.  

(ii) Merged tables can be compared historically because road names and road types are 

fixed per location data.  

Steps:  

(i) Creation of < 100m road links based on unique road coordinates from Waze  

(ii) Determine all unique jam-road link intersections 

(iii) Determine the average speed per road link based on the speeds of the jams along them 

(iv) Estimate the free-flow speed per road link based on speeds and travel times along 

unjammed portions of the road links  

(v) Fill in free-flow speeds for road links and times that did not have jam data for a given 

road link.   

(c) Speed and Merged Table 

The Speed and Merged table are the resulting BigQuery table from the aggregated jammed 

speeds and free-flow speeds per road link. Initially, we use the jammed speeds to determine 

the average speed for a road link, however, in cases such that a road link does not have 

jam data, we estimate the free-flow speed for the road link based on speeds and travel 

times along its unjammed portions. We use the estimated free-flow speed to fill in the 

average speeds for road links that do not have jam data. The Speed and Merged table is 

the data source used by the JICA Dashboard Web application. 

(4) Dagster 

(a) Dagster Instances 

Waze Data 

Query Jams for Metro Manila 
Create Roadlinks 

by < 100m Lengths 

Get Jam Speeds 
Get Freeflow 

Speeds 

Lookup Table 
of jam-roadlink Intersections 

Merged_Table 

Overlay Unjammed Roadlinks and 
times With Freeflow Speeds 
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Table 2.16:  Dagster Instances 

Instance/VM Description 

dagster-monthly VM instance that hosts the monthly Waze Speed 
Calculation pipeline for production use. 

dagster-monthly-dev VM instance that hosts the monthly Waze Speed 
Calculation pipeline for development use. 

dagster-historical VM instance that hosts the historical Waze Speed 
Calculation pipeline for production use. 

dagster-historical-dev VM instance that hosts the historical Waze Speed 
Calculation pipeline for development use. 

Source: JPT 

(b) Dagster Pipelines 

There is a single dagster pipeline responsible for orchestrating the Waze Speed calculation 

and producing the final BigQuery tables for the Dashboard web app: waze_lookup_pipeline. 

The dagster instance image is deployed as a Docker container in the dagster Compute 

Engine instance. The waze_lookup_pipeline does not have any defined scheduler in code 

to orchestrate the project's objective monthly run; rather we let the Instance Schedule 

monthly-speed-calculation-schedule run the pipeline for us in 1-month intervals. 

(c) VM: Dagster (Prod) 

All output tables produced by the Waze Speed calculation pip fall under one dataset which 

is the waze_lookups dataset. 

(d) Output Tables 

Table 2.17:  Output Tables 

Pipeline Dataset Table 

waze_lookup_pipeline waze_lookups webapp_table_<date> 
webapp_table_old_format 
aggeregates_per_minute 
all_jams 
distinct_jam_coordinates 
free-flow_speeds 
jam_roadlink_intersection_lookup 
jam_roadlink_intersection_dir 
jam_roadlink_intersection_exploded 
jam_roadlink_intersection_lookup_with_mls 
jam_roadlink_intersections 
raw_jams_spatiotemporal_filter 

Source: JPT 

(e) Pipeline Notifications 

Every month an email notification will be sent to stakeholders and maintainers of the project 

showing the results of the Waze Speed Calculation pipeline. 
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Source: JPT 

Figure 2.9:  Example of a Pipeline Notification 

(f) Trigger a Manual Run 

Should the clients, stakeholders, or maintainers of the project decide to run the Waze Speed 

Calculation pipeline manually, it can be done by starting/restarting the dagster VM/Compute 

Engine instance via the Google Cloud Console. 

 Step 1 

Look up or search "Compute Engine" in the Google Cloud Console search bar and click the 

first search result item: Compute Engine.  

 
Source: JPT 

Figure 2.10:  Google Cloud Console Search Bar 

 Step 2 

Locate the dagster item under the INSTANCES tab and click the More actions icon or the 

vertical three dots icon on the right side, click Start/Resume if the dagster item is currently 

stopped denoted by the Status column. If currently running and not stopped, click Stop 

instead and click Start/Resume again after stopping. 
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Source: JPT 

Figure 2.11:  Waze Speed Calculation 

The Waze Speed Calculation will now run. 

(5) Types of Manual Triggers 

Table 2.18:  Types of Manual Triggers 

VMs Purpose VM Details  

dagster-monthly Runs the Waze Speed Calculation pipeline on 
the previous month's raw Waze traffic data; 
scheduled to run every first day of the month 
but can be manually triggered as well 

1 vCPU, 3.75 GB memory 

dagster-historical Runs the Waze Speed Calculation pipeline on 
the raw Waze data from 2018 up until the last 
day of the previous month; manually triggered 

2 vCPUs, 13 GB memory 

Source: JPT 

(6) Monthly Run  

Manually triggering a monthly run is needed if the scheduled monthly run every first day of 

the month fails due to intermittent and unlikely reasons such as down services, or internet 

connectivity issues in the Compute Engine instance of the pipeline. If manual intervention 

from the maintainers of the project is needed to fix unforeseen issues to get the pipeline 

running again, the monthly run will have to be manually triggered after the issue has been 

resolved. 

Table 2.19:  How to Do Monthly Run Manually 

Issue Details Actions Required 

Speed Calculation 
Fails 

Information on the failed task will be 
elaborated further on the email 
notification sent to stakeholders after 
the run has concluded. 

Start/Restart the dagster-monthly 
Compute Engine Instance in the 
GCP UI to re-trigger the speed 
calculation for the previous month. 

Source: JPT 

(7) Full Run  

Manually trigger a historical run is needed if the stakeholders decide to update the road 

links data used for the speed calculation from 2018 up until the current date. 
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Table 2.20:  How to Do Full Run Manually 

Issue Details Actions Required 

Road links Data 
Change 

The roadlinks data in the roadlinks_v6 
BigQuery table is based on a file 
provided by the JICA stakeholders. 
Should the stakeholders decide to 
update the roadlinks data used on 
both the speed calculation and the 
dashboard web app, maintainers of 
the project should update the 
roadlinks_v6 and _roadlink_lookup 
table accordingly 

Contact Thinking Machines and provide the 
updated roadlinks file. 

The maintainers of the project should manually 
update the roadlinks_v6 and _roadlinks_lookup 
BigQuery tables in the waze_lookup dataset. Other 
than the BigQuery tables mentioned, the 
geometries.json file in the JICA Dashboard Web 
App Github repository should be updated as well. 

After updating the roadlinks data, start/restart the 
dagster-historical Compute Engine Instance in the 
GCP UI to trigger the historical speed calculation. 

Source: JPT 
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2.4 Dashboard 

The Web App Dashboard is intended to visualize jams at a road link level.  

Table 2.21:  Web App Dashboard Button Details 

No Button/Filter Details 

1 % of Time Below KPH Only displays the roadlinks that meet the % occurrence  

2 Speed Only displays the roadlinks that are selected in the range 

3 Worst Roadlinks Based 
on Percentage of Time 

Narrows down the search to worst roadlinks in terms of 
jams/delays  

4 Roadlinks with Speed 
Below KPH 

Only displays the roadlinks that are selected in the range  

5 Color Bar Color symbols of how fast/slow a roadlink is. This is 
affected by the roadlink speed filter    

6 Time of Day (Only at the speed filters)  
Select from hourly times of day   

7 Year Select the year  

8 Day of Week Select the day of the week  

9 Month Select the month of the year  

10 Road Type Select the road type as determined by the JICA (previously 
determined by Waze data, but due to randomness of the 
raw data labeling, this was made consistent by JICA) 

11 Direction d0 - East Bound / North Bound  
d1 - West Bound / South Bound  

12 Update Map Displays the queried results 

13 Export Data as CSV Download as a csv file the data shown on the dashboard 
based on the filters selected   

14 Clear all Filters Restores all filters to default  
Source: JPT 
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Source: JPT 

Figure 2.12:  Select Button / Filter in Dashboard 
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2.5 Access Management 

(1) Updating Dashboard User Access 

In order to add or remove emails with access to the Web App Dashboard, the developer 

must redeploy the mmda-waze-jica-dashboard-<environment> service in Cloud Run. 

(a) Step 1 

Look up or search "Cloud Run" in the Google Cloud Console search bar and click the first 

search result item: Cloud Run.  

 
Source: JPT 

Figure 2.13:  Cloud Run 

(b) Step 2 

Locate and click the Cloud Run service you want to redeploy; for example, the mmda-waze-

jica-dashboard-dev service. 

 
Source: JPT 

Figure 2.14:  Selecting Cloud Run Service 

(c) Step 3 

After clicking the Cloud Run service of your choice; the user will be redirected to the Cloud 

Run Service details page; click the EDIT & DEPLOY NEW REVISION button. 

 
Source: JPT 

Figure 2.15:  Edit and Deploy New Revision Button 
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(d) Step 4 

In the Deploy revision page of the mmda-waze-jica-dashboard-<environment> service, 

click the VARIABLES AND SECRETS tab 

 
Source: JPT 

Figure 2.16:  Variables and Secrets Tab 

(e) Step 5 

Locate the Environment variables section under the VARIABLES & SECRETS tab, and 

update the value of the EMAILS variable; either append a new email address separated by 

a comma sign, or remove an old email address. 

 
Source: JPT 

Figure 2.17:  Environment Variables 

(f) Step 6 

Click the DEPLOY button at the bottommost part of the Deploy revision screen. 
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Source: JPT 

Figure 2.18:  Deploy Button 

(2) Updating Access to the Web App Cost Metrics 

Other than controlling access to the Web App Dashboard service itself, we can also manage 

users who can view the web app cost metrics for monitoring query usages, quota, and 

billing.  

 
Source: JPT 

Figure 2.19:  Screenshot of Cost Estimation in Dashboard 

However, with the current implementation of the web app dashboard from phase one of the 

project, users with access to this view can only be updated via changes in the web app 

source code which requires assistance from Thinking Machines.  

(3) Dashboard Year, Month, and Day Filters 

The combination of values you select in the date filters will determine the roadlinks data to 

be displayed in the dashboard map view. Specifically, different combinations of filters will 

result in varying roadlink speeds average in the map view which is shown by the color of 

the roadlinks/line segments. Clicking the "UPDATE MAP" button in the dashboard 

computes the average speed of the roadlinks over the selected dates determined by the 

date filters. 

For example, selecting only Mondays from the month of September year 2021 will only 

compute the average roadlinks speeds over four (4) days or ninety-six (96) hours since 

there are only four Mondays in September 2021. In order to verify this, hovering over a 

displayed roadlink in the map view will show a pop-up displaying the following information 

with regards to the hovered-over roadlink: name, average speed, average speed in 

direction d0, average speed in direction d1, and percent of time below N-kph. 

 

 



The Project for Comprehensive Traffic Management Plan for Metro Manila 
TECHNICAL REPORT NO. 3: WAZE DATA DASHBOARD AND USER MANUAL 

 

2-28 

 

 

Source: JPT 

Figure 2.20:  Screenshot of Year, Month, and Day Filter in Dashboard 

(4) Querying for Merged Tables  

—---------------------------------------------------------------------------------------------------------------------  
select New_ID,roadlink_id,a.street_unique,a.direction,roadType,day, time, speed   from 

(select street_unique, day, time, speed,direction FROM `mmda-waze.waze_lookups.__webapp_table_old_format` WHERE 

date = "2021-11-29") a 

left join 

(SELECT * from `mmda-waze.waze_lookups.webapp_reference_table`) b 

on a.street_unique = b.street_unique 

and a.direction=b.direction 

order by a.street_unique,a.direction, day, time 

—---------------------------------------------------------------------------------------------------------------------  
Change this value to query a different date. 
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2.6 Known Limitations 

These are all the known issues. There may be more issues not yet found.  

(1) Slow Dashboard Load Times  

Slow loading times may be due to the individual user’s internet connectivity, or hardware 

limitations 

Slow loading times may also be due to Cloud Run's "cold start". If the service is not used 

for an unspecified amount of time, Google terminates the web app dashboard. Using the 

web app again after it has been terminated requires the Cloud Run instance to re-download 

the web app dashboard requirements (docker image) and start it again. Increasing the 

minimum instances to make a warm start would increase resource costs unnecessarily. 

(2) Waze Data Limitations 

(a) Waze GPS Data Changes Every Run 

Challenge:  

 The Waze road data (marked by the red lines) is not the same on every run.  

 This will not line up with the road links data set by JPT in Road links v6.  

 If the road data is not captured at all, the data will assume it is free-flowing.  

 
Source: JPT 

Figure 2.21:  Example of Waze GPS Data which Does Not Match Road Links 

Solution:  

 Buffer zones (marked by the blue highlights) will be created that will detect any Waze 

road data in the buffer zones like a map matching.  

Implications:  
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 There is a higher chance the Waze road data will be captured.  

 The buffer zones are still able to distinguish overlapping road data due to overpasses 

or fly-overs.  

 The buffer zones may inadvertently capture road traffic from other roads that are 

overlapping or intersecting. This can understate or overstate traffic speed data.  

(b) Some Road Links Do Not Have Any Jams Data  

 Red lines represent all jams from 2020-05 to 2021-07 

 Cyan highlights represent road links without any data (e.g. village, military area, etc.) 

 5,000 out of 59,000 road links do not have jam data   

  
Source: JPT 

Figure 2.22:  Example of Road Links which Has No Waze Data 

(c) When Waze Updates their Underlying Roadmap Location 

Challenge: 

 Waze updated its underlying map from the 2018 map which road links v6 is based on.  

 This is a special case that cannot be handled by widening the buffer of the road links 

v6 since the roads are in completely different locations.  

Implication:  

 Certain road links will not be captured because the Road links v6 location is wrong 
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Source: JPT 

Figure 2.23:  Example of New Waze Road Links 

(d) Road Links based on U-turns Cannot Be Captured 

Challenge: 

 The methodology for dropping irrelevant intersections is based on the angle between 

the endpoints of the road link and the intersection.  

Implication: 

 There is a possibility that the jams of U-turns will not be attributed to the U-turn road 

link.  

 
Source: JPT 

Figure 2.24:  Example of a U-turn which Cannot Be Captured 
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(e) Waze Road Data can Shift and Might Not Be Consistent from Run to Run 

Challenge: 

 The Waze road data (marked by the red lines) is not the same in every run. This does 

not line up with the road links data set by JICA in Road links v6.  

 If the road data is not captured at all, the data will assume it is free-flowing.  

 
Source: JPT 

Figure 2.25:  Example of Inconsistent Waze Data  

Solution: 

 Buffer zones (marked by the blue highlights) will be created that will detect any Waze 

road data.  

Implication:  

 There is a higher chance that the Waze road data will be captured.  

 The buffer zones are still able to distinguish overlapping road data due to overpasses 

or fly-overs.  

 The buffer zones may inadvertently capture road traffic from other roads that are 

overlapping or intersecting. This can understate or overstate traffic speed data. 

(f) Increasing the Buffer Zone Size May Make It Harder to Differentiate the 

Overlapping and Intersecting Roads 

Challenge: 

 Overlapping roads can affect the captured speed data of the roads below and/or above.  

 Perpendicular roads may affect the speed of the main roads 
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Source: JPT 

Figure 2.26:  Example of Problem Due to Increasing Buffer Size 
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Solution: 

 Create a code wherein the data will not be captured by the road if the angle of two 

intersecting and overlapping lines is more than 20 degrees. 

 This is how we remove roads that are not part of the original road. 

(g) New Traffic Areas and New Roads will Not Be Captured. This Appears as Red 

Lines Without Buffer Zones 

Challenge: 

 New road data that comes in for streets will not be captured in methodology 2 because 

road links v6 are fixed.  

 This happens when Waze captures new traffic data in areas it did not capture before 

(i.e., 2018, 2019).  

 This is unique to methodology 2 because it is based on road links v6.  

Implication 

 New road links will not be properly captured.  

 
Source: JPT 

Figure 2.27:  Example of New Waze Data on Road Links Not Captured Before 
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3 USER MANUAL  

3.1 Instructions 

(a) Go to the Dashboard at this link: https://mmda-waze-jica-dashboard-prod-zya4adr2eq-

uc.a.run.app/ 

(b) Select the different filters to the left of the Dashboard to change the results shown on 

the screen. 

 
Source: JPT 

Figure 3.1:  Waze Data Dashboard 

(c) Switch between % of Time below KPH filters and speed filters by clicking on the 

respective columns. 

 
Source: JPT 

Figure 3.2:  Data Set Type 

https://mmda-waze-jica-dashboard-prod-zya4adr2eq-uc.a.run.app/
https://mmda-waze-jica-dashboard-prod-zya4adr2eq-uc.a.run.app/
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(d) Select a filter by clicking on the drop-down button. 

 
Source: JPT 

Figure 3.3:  Percentage of Time Below the Speed 

(e) Drag Roadlinks with a speed bar to change the values or directly input the values. 

 
Source: JPT 

Figure 3.4:  Speed Range 

(f) The different colors shown on the map will correspond to the speed of the roadlink.  

(g) For some filters, you will be able to ‘Select All’ the values. This will filter to all the values. 
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You can also ‘Clear All’ to unselect all the values.  

 
Source: JPT 

Figure 3.5:  Selecting Year, Day, Month, and Road Type 

(h) When you have selected the necessary filters, click ‘Update Map’ to apply the filters on 

the Map.  

 
Source: JPT 

Figure 3.6:  Update Map Button 

(i) To download the data of the filters selected on the dashboard, click ‘Export Data as 

CSV’. 
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Source: JPT 

Figure 3.7:  Export Data As CSV Button 

(j) Click on the ‘Clear all filters’ button to reset all filters back to the default values. 

 
Source: JPT 

Figure 3.8:  Clear All Filters Button 

(k) You can adjust the Dashboard visual by changing the ‘Switch Basemap’. 

 
Source: JPT 

Figure 3.9:  Base Map Options 

(l) For certain key users, the cost associated with the dashboard will be visible. 
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Source: JPT 

Figure 3.10:  Cost Summary 

(m) For more details on the Dashboard and the back-end, refer to the Design and Technical 

Documentation. 

(n) For more details on the data refer to the Data Dictionary and Processing Documentation. 

 

 

https://docs.google.com/document/d/1Kd7NW03t3kdeahNE37HEl1AlcUxksJhjqRPdceZuTA8/edit#heading=h.xmq7s4s2jxgb
https://docs.google.com/document/d/1Kd7NW03t3kdeahNE37HEl1AlcUxksJhjqRPdceZuTA8/edit#heading=h.xmq7s4s2jxgb
https://docs.google.com/spreadsheets/d/1l_t69beEc-4beIDOPFuOSIi1LFOHpRbiO5RR87D_bI0/edit#gid=1199105118
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Source: JPT 

Figure 3.11:  Web App Dashboard 
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1 INTRODUCTION 

1.1 Objectives 

The first activity in identifying traffic bottlenecks (TBNs) and understanding the pre-

pandemic traffic situation in Metro Manila is administering questionnaire surveys by MMDA 

and the 17 NCR LGUs in 2019. Based on the results of the first questionnaire survey, MMDA 

identified 102 bottlenecks, while the LGUs listed 187 locations, or a total of 289 TBNs, 

including road segments. However, it should be noted that these bottlenecks were identified 

subjectively.  

For this reason, the objectives of this chapter are to define traffic bottlenecks and identify 

the major traffic bottlenecks in Metro Manila. By identifying the bottlenecks, the expected 

outcomes are as follows: 

(i) Common understanding among the MMDA and related parties about the trend of traffic 

congestion in Metro Manila; 

(ii) Clear definition of traffic bottlenecks for Metro Manila based on quantitative analysis; 

(iii) Longlist of traffic bottlenecks in Metro Manila; and 

(iv) Strengthened capacity for identifying traffic bottlenecks using a data-driven 

methodology. 

1.2 Overall Approach 

The overall approach to identifying bottlenecks is shown in Figure 1.1. The identified 

bottlenecks by MMDA and the LGUs were first screened using the Waze travel speed data. 

TBNs based on Waze travel speed data that were not yet identified by the MMDA and LGUs 

were added to the potential longlist while TBNs initially determined were retained. 

In the second screening, the JPT prepared a datasheet for data collection which will be 

used for site observation by the traffic enforcers. Then, the TBNs will be classified into 

intersections, road segments, and areas according to the site conditions. Also, the typology 

will be made depending on the causes of congestion. Through these steps, the longlist of 

major TBNs will be finalized.   

   
Source: JPT  

Figure 1.1:  Workflow for Longlisting Major Traffic Bottlenecks 

1st ScreeningIdentification of TBNs

Opinion by MMDA, LGUs

Data Analysis and Prioritization of 

TBNs

Identification of Major TBNs

Identification of target 
intersections 

Road Classification (A,B,C)

Start: all intersections 

Site Observation by MMDA

(Checking congestion 
factors at intersections)

Data Collection for Each 
TBN

2nd Screening

Primary

Database

TBN Database 

Database

Conversion of travel speed 
data from Waze data

Longlist

Shortlist





The Project for Comprehensive Traffic Management Plan for Metro Manila 
TECHNICAL REPORT NO. 4: IDENTIFICATION OF TRAFFIC BOTTLENECKS AND MONITORING 

 

2-1 

2 DEFINITION OF TRAFFIC CONGESTION AND TRAFFIC 

BOTTLENECKS 

2.1 Basic Traffic Engineering Knowledge of Traffic Congestion 

Before defining traffic congestion and bottlenecks, the basic traffic engineering knowledge 

is described in this section for a better common understanding. Traffic congestion is a 

phenomenon caused by a pile-up of traffic demands which cannot be accommodated in the 

network. Meanwhile, a bottleneck is a point in the target area where traffic capacity is the 

lowest. It commonly becomes the starting point of traffic congestion. Figure 2.1 illustrates 

the concept of traffic congestion and traffic bottleneck. Traffic flow forms a queue at the 

upstream section of a bottleneck when traffic demand exceeds the traffic capacity of that 

bottleneck.  

 
Source: JPT based on material of Takashi Oguchi, Professor of "Traffic Management & Control", the University of Tokyo 

Figure 2.1:  Concept of Traffic Congestion and Traffic Bottleneck 

The graph in Figure 2.2 shows the relationship among traffic demand, traffic capacity, and 

queue length. The horizontal line in the graph represents time, while the vertical line in the 

first graph is traffic volume. The vertical line in the second graph represents queue length. 

Traffic congestion starts when traffic demand (traffic volume) exceeds the traffic capacity. 

When traffic demand exceeds the capacity, traffic congestion continues, and the queue 

lengthens. Since excess traffic demand accumulates, the longest queue is observed when 

the excess demand disappears. When traffic demand is lower than capacity, the vehicle 

queue shortens. Then, when the number of vehicles stuck in traffic congestion is handled, 

traffic congestion eases.    

Demand(arrival)  > Throughput(departure)
=bottleneck capacity

water(=traffic)
tube(=road) diameter(appx. traffic capacity)

e.g. Intersection, 
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Source: JPT 

Figure 2.2:  Relationship among Traffic Demand, Capacity, and Queue Length 

There are two conditions when a point or a segment becomes a traffic bottleneck, as 

illustrated in Figure 2.3. The first is when traffic demand exceeds traffic capacity (excess 

demand over capacity) due to concentrated traffic caused by narrow road segments, for 

instance, thereby resulting in traffic congestion. In this case, improvements, such as road 

widening, grade separation with a flyover, or connection of missing links, are required. The 

second condition is when the original road capacity is reduced caused of obstructions, such 

as on-street parking and PUV terminals, resulting in traffic congestion even though traffic 

demand does not exceed the original traffic capacity. In this case, traffic management 

measures, such as enforcing parking regulations, are required. 

 

 

Condition 1: Excess Demand over Capacity Condition 2: Reduced Capacity 
Source: JPT 

Figure 2.3:  Conditions of Bottlenecks Resulting in Congestion 

From a traffic engineering perspective, traffic flow is defined by three (3) parameters, i.e., 

flow, density, and speed, as shown in Table 2.1. 
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Table 2.1:  Three Parameters of Traffic Flow  

Parameter Definition 

Flow (traffic volume) Q the traffic volume or number of vehicles that have passed a certain point 

Density k in [vehicle/km] the number of vehicles that exist in the unit length of road 

Speed v in [km/h] the mean speed of vehicles 
Source: JPT 

These parameters are interrelated, as shown in Figure 2.4. The maximum traffic capacity 

of a given section is determined when the traffic flow rate is at its maximum (Q-Max). When 

the density is greater than that, it becomes a congested flow area where the speed 

decreases. While it is possible to measure traffic flow rates at individual intersections, speed 

can also be used as an indicator of traffic conditions and an identifier of a bottleneck. On 

the other hand, since daily traffic capacity can be reproduced from traffic volume estimates, 

macro analysis can be utilized to determine the traffic demand. 

  
Source: Highway Capacity Manual 2000. 

Figure 2.4:  Conditions of Bottlenecks Resulting in Congestion 
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2.2 Definition of Common Criteria of Traffic Congestion and Bottlenecks 

(1) Aggregation and Development of Waze Travel Speed Data 

Under the Connected Citizens Program, MMDA can obtain travel speed data from Waze, a 

navigation company. Such data can provide a bird's eye view of the entire Metro Manila. In 

this CTMP Project, the Waze travel speed data in 2019 was collected and aggregated per 

100-meter link. A dashboard web system was developed to visualize the data for any given 

time, day of the week, month, and by road class. By using this travel speed data from Waze, 

the traffic situation in Metro Manila was analyzed, and the common criteria for traffic 

bottlenecks were considered.  

(2) Target Intersections 

For the identification of TBNs where effective traffic management should be applied, roads 

were first classified by function, i.e., A, B, C, and D, as shown in Table 2.2. Based on the 

proposed network classification, target intersections were selected. These are composed 

of A-A roads, A-B roads, A-C roads, and B-B roads, as shown in Table 2.3. The number of 

target intersections has a total of 751, and the locations are shown in Figure 2.6. 

 
Source: JPT 

Figure 2.5:  Developed Dashboard for Travel Speed Data from Waze 

Table 2.2:  Road Classification for Traffic Management Planning 

Road 
Classification  

Definition/Function 
Responsibility for 

Construction 
Responsibility 

for TM 

Expressway  
A major road with a median strip, access 
control and a curb shoulder. Toll fee needed. 

DPWH, Private DPWH, Private 

Class A 
A major road that mainly connects cities, 
excludes expressways. Refers to the radial and 
circumferential roads. 

DPWH, Private MMDA, Private 
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Road 
Classification  

Definition/Function 
Responsibility for 

Construction 
Responsibility 

for TM 

Class B 
A road that complements Class A roads. An 
access road to major roads or facilities. 

LGUs, Private 
MMDA, LGUs, 
Private 

Class C 
A road that complements Class B roads, 
connecting roads in residential subdivisions, 
and adjacent barangays within a city. 

LGUs, Private LGUs, Private 

Class D 
The least important road. An access road to 
facilities within a city. A living road that give 
priority to pedestrians. 

LGUs, Private LGUs, Private 

Source: JPT 

Table 2.3:  Target Intersections as Traffic Bottlenecks 

Class of Intersection No. of Intersections 

1 Class A x Class A 95 

2 Class A x Class B 224 

3 Class A x Class C 321 

4 Class B x Class B 111 

Target Intersections in total 751 

(Others) (>10,000) 
Source: JPT 
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    Source: JPT 

Figure 2.6:  Target Intersections as Potential Traffic Bottlenecks 
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2.3 Definition of Bottlenecks 

The level of service (LOS) is commonly used in traffic analysis to qualitatively examine 

traffic conditions and travel services. According to the Highway Capacity Manual, LOS is a 

qualitative measure describing operational conditions within a traffic stream based on 

service measures such as speed and travel time, freedom to maneuver, traffic interruptions, 

comfort, and convenience. By referring to the LOS, the JPT proposed a new indicator 

named level of congestion (LOC) to identify traffic bottlenecks. LOCs are determined by 

travel speed, i.e., when travel speed is low, the LOC is high. Acceptable travel speeds differ 

depending on the road classification and function. Different thresholds of LOC were 

proposed for each road class, as shown in Figure 2.7. For Epifanio de los Santos Avenue 

(EDSA) and Circumferential Road 5 (C-5), which are classified as Class A roads, access 

roads connecting to them are relatively few compared to other Class A roads. Road users 

expect higher travel speeds when using them, so a different threshold from that of Class A 

roads was applied to EDSA and C-5. In determining the LOC of an intersection, the travel 

speed of inflow traffic on each leg of the intersection was used as a basis. 

 
Source: JPT 

Figure 2.7:  Level of Congestion by Road Class 

Based on the new indicator, LOC, the target intersections were evaluated (Figure 2.8). An 

intersection’s LOC was determined using the 2019 average travel speed data obtained from 

Waze, which covers weekdays from 6:00AM to 8:00PM, for inflow traffic on each leg of an 

intersection. An intersection was regarded as a TBN when its LOC in at least one direction 

is 3 or more.  

In summary, a TBN is defined as “an intersection/point whose inflow traffic in at least one 

direction has an LOC of 3 or more.” Based on this definition, the 751 target intersections 

were narrowed down to 164 TBNs (Table 2.4 and Figure 2.9). 

 
Source: JPT 

Figure 2.8:  Flow of Identifying TBNs 
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Table 2.4:  Number of Traffic Bottlenecks Based on Waze Data 

Class 
No. of Intersections 

Target TBN (LOC = >3) 

1 A x A 95 50 

2 A x B 224 58 

3 A x C 321 50 

4 B x B 111 6 

Total 751 164 (33%) 
Source: JPT 

 
Source: JPT 

Figure 2.9:  Traffic Bottlenecks based on LOC >=3 
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(1) Checking and Adding of TBNs Identified by MMDA and LGUs 

As mentioned earlier, questionnaire surveys were distributed to MMDA offices and 17 LGUs 

in Metro Manila in 2019 to identify traffic bottlenecks. In the process, MMDA and the LGUs 

subjectively identified traffic bottlenecks. Table 2.5 breaks down the target intersections into 

those identified by MMDA and the LGUs in the questionnaire surveys. The 109 intersections 

identified by MMDA and LGUs are included in the 751 target intersections. Furthermore, 

the bottlenecks identified by MMDA and LGUs include 10 non-intersections such as U-turn 

slots or merging points.  

Table 2.5:  Breakdown of Target Intersections by Government Office  

Class of Intersection 
Number of Intersections/TBNs 

Target MMDA + LGUs 

1 A x A 95 36 

2 A x B 224 41 

3 A x C 321 30 

4 B x B 111 2 

Total 751 109 

Line - 15 
                   Source: JPT 

Next, the 164 TBNs identified based on Waze travel speed data, and 109 TBNs from MMDA 

and LGUs were compared to sort out overlapping points, as summarized in Table 2.6 and 

shown in Figure 2.10. Out of the 109 TBNs identified by both MMDA and LGUs, 64 overlap 

with those identified based on Waze travel speed data, while 45 locations do not overlap. 

Since the 45 locations of non-overlapping TBNs are possible TBNs, they were added into 

TBNs as well.  

Table 2.6:  TBNs based on LOC and Government Office 

Intersection 
Type 

Initially Identified TBN No. of Overlapping 
TBNs (>=LOC3 & MMDA 

+ LGU 

No. of Non-overlapping TBNs 

Total 
TBN with 
>= LOC3 

TBN Identified by 
MMDA + LGU 

>= LOC3 MMDA + LGU 

A x A 61 50 36 25 25 11 

A x B 75 58 41 24 34 17 

A x C 66 50 30 14 36 16 

B x B 7 6 2 1 5 1 

Total 209 164 109 64 100 45 
Source: JPT.  

In conclusion, the total number of TBNs is 209 points, 164 TBNs were identified using Waze 

travel speed data and 109 TBNs were determined by the MMDA/LGUs. An overlap of 64 

TBNs were existing on the list of both MMDA/LGU and LOC based method. 

 
Source: JPT 

Figure 2.10:  TBNs Identified based on LOC and Government Office 
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Of the 209 bottlenecks identified based on travel speed and observation by MMDA and 

LGU counterparts, 42 locations were deemed as serious bottlenecks facing severe 

congestion. They are shown in Figure 2.11.  

  
Source: JPT 

Figure 2.11:  Location of Identified TBNs
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3 SHARED UNDERSTANDING OF TRAFFIC CONGESTION AND 

BOTTLENECKS 

3.1 Traffic Situation in Metro Manila 

Figure 3.1 illustrates the traffic situation in Metro Manila before the COVID-19 pandemic. 

This was based on Waze travel speed data. As observed in the figure, a single bottleneck 

at an intersection extends to the segments along the corridor until the surrounding area as 

congestion becomes more severe. 

 
Source: JPT 

Figure 3.1:  Pre-pandemic Traffic Situation in Metro Manila based on Waze Data
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3.2 Traffic Conditions in TBNs 

As mentioned earlier, the TBNs were identified using two approaches: by LOC based on 

Waze travel speed data and by questionnaire surveys administered by MMDA and the 

LGUs. This section spells out the traffic condition.  

(1) Overlapping Points (Class A x Class A) 

Among the TBNs identified by MMDA and the LGUs, those that were judged as TBNs with 

LOCs of greater than 3 and are overlapping with Waze travel speed data were included in 

the TBNs. Table 3.1 shows the detailed information about selected overlapping points 

regarding their traffic condition. These points are found to be low-speed sections at least in 

the inflow direction of a major road. 

Table 3.1:  Traffic Conditions in Overlapping AxA Bottlenecks 

Intersection 
Name 

EDSA–Shaw Boulevard Lacson Ave.–Laong Laan St. 

Location Mandaluyong Manila 

Map 

  
Class A x A A x A 

MMDA or 
LGU 

TBN identified by MMDA TBN identified by LGUs 

LOC TBN identified by LOC ( >= LOC3) TBN identified by LOC (>= LOC3) 

LOC of Each 
Inflow 

Direction 

D1: 15.2km/h: LOC3 (EDSA) 
D2:  8.9km/h: LOC3 (Class A) 
D3: 16.0km/h: LOC3 (EDSA) 
D4: 10.5km/h: LOC3 (Class A) 

D1: 11.8km/h: LOC3 (Class A) 
D2: -  
D3: 10.5km/h: LOC3 (Class A) 
D4: 23.8km/h: LOC1 (Class A) 

Source: JPT 

 
Source: JPT 

Figure 3.2:  Leg Numbering System 
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(2) Non-overlapping Points (Class A x Class A) 

Among the TBNs identified by MMDA or the LGUs, those that did not fall under LOC 3 to 4 

criteria were added to the TBNs as well. Table 3.2 describes the detailed information 

regarding representative non-overlapping points with their traffic conditions. Most of the 

non-overlapping TBNs are located along Class A roads, such as, MacArthur Hwy., EDSA, 

Commonwealth Ave., Ortigas Ave., and Alabang-Zapote Rd. Large variation between travel 

speed data from 6:00am to 8:00pm from these road sections may be the reason why the 

average travel speed data resulted to LOC values lower than 3.  

Table 3.2:  Traffic Conditions in Non-overlapping AxA Bottlenecks  

Intersection 
Name 

EDSA–MacArthur Highway Quirino Highway–Commonwealth Avenue 

Location Caloocan Quezon City 

Map 

  
Class A x A A x A 

MMDA or 
LGU 

TBN identified by MMDA and LGUs TBN identified by LGUs 

LOC Not TBN identified by LOC (>= LOC3) Not TBN identified by LOC (>= LOC3) 

LOC of Each 
Inflow 

Direction 

D2: 21.6km/h: LOC2 (EDSA) 
R1_3: 32.2km/h: LOC0 (EDSA) 
R2_1: 29.2km/h: LOC0 (Class A) 
D1: 18.0km/h: LOC2 (Class A) 

D4: 26.7km/h: LOC0 (Class A) 
D2: 21.6km/h: LOC1 (Class A) 
D3: -  
D1: 36.5km/h: LOC0 (Class A) 

Source: JPT 

(3) Non-intersections along Class A Roads 

The U-turn slots and merging points which MMDA or the LGUs identified as traffic 

bottlenecks are located on Class A roads, as shown in Table 3.3. These segments should 

be checked and added to the TBNs, as well.  

Table 3.3:  Non-intersections along Class A Roads 

Name EDSA, Santolan Crame U-turn slot 
EDSA SM North Annex - U-turn Slot 

Corregidor – U-turn Slot 

Map 

  
Class A A 

MMDA or LGU TBN identified by MMDA TBN identified by MMDA 
Source: JPT 
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3.3 Classification of Traffic Bottlenecks 

Classifying the identified TBNs will create appropriate measures against traffic congestion. 

For instance, if several TBNs are on the same road and adjacent to each other, grouping 

them would suggest a holistic solution that would be more effective to the entire corridor. 

As mentioned earlier, there are two conditions when a point or a section becomes a TBN: 

excess demand over capacity and reduced capacity. Moreover, the severity and direction 

of traffic congestion or the queue length may differ depending on site conditions. Therefore, 

classifying bottlenecks would be essential to make localized measures in tackling 

congestion. 

1) Typology of Traffic Bottlenecks  

To determine the major TBNs from the 209 identified TBNs, they were categorized 

according to intersection type, the severity of congestion, structure and signal type, number 

of crossing conflicts and legs, and implementation possibility (Table 3.4).  

Table 3.4:  Traffic Bottleneck Categories 

Category Typology 

Intersection Type  Major Corridor: Class A x Class A, B, C 
 Minor Corridor: Class B x Class B 

Severity of Congestion  High congestion level (LOC>=3)  
 Long queue length in each leg 

Structure and Signal Type  Signalized or non-signalized  
 At-grade or Segregated (Elevated) 

Crossing Conflict/No. of Legs  Many conflict locations  

Implementation Immediately  Short-term / Easy implementation 
 Long term / Difficult implementation 

Source: JPT 

High priority was given to intersections comprising at least one Class A road. Structure and 

signal type identify signalized and non-signalized intersections, as well as at-grade and 

segregated (grade-separated) intersections. The number of crossing conflicts in, and legs 

of, an intersection determines the time to turn to other directions and the probability of a 

road crash. The more crossing conflicts there are, the higher the probability of being stuck 

in traffic or causing road crashes, especially if an intersection is non-signalized. 

Implementation possibility is also considered since priority TBNs need immediate action. 

Long-term plans may be difficult to execute, since they might require a higher budget, new 

infrastructures, and land acquisition. Major, or high-priority, TBNs fall under the high severity 

/ short-term implementation criteria, as shown in Figure 3.3.   

Meanwhile, the severity of congestion is based on two factors: level of congestion (LOC) 

and queue length. For LOC, LOC A refers to the initial TBNs selected by MMDA and LGUs. 

LOC B to D are dependent on the number of approaches or directions with an LOC of 3 or 

4 a TBN has.  
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Source: JPT 

Figure 3.3:  Criteria for Major TBNs 

Table 3.5:  Severity of LOC 

Severity of LOC 

A Selected by MMDA/LGUs 

B =1 Direction has >= LOC3 

C >=2 Directions have >= LOC3 

D All Directions have >= LOC3 
Source: JPT 

Queue length relies on the site observation done in 2021 by MMDA traffic enforcers in the 

209 TBNs. In the questionnaire they accomplished, they estimated the queue length per 

approach of each TBN, indicating “01” for the longest queue and “04“for no queue or less 

than 100-m queue length. Queue Length 1 means that at least two approaches have 

moderate queue lengths, while Queue Length 6 means at least one direction has over 500m 

queue length.  

Table 3.6:  Severity of Queue Length 

 

Source: JPT 

Table 3.7 classifies the long-listed TBNs by intersection type, signalization, and structure. It 

shows that: (i) 164 (78%) of the 209 long-listed TBNs satisfy the LOC criteria; (ii) 92 (44%) 

are non-signalized intersections, implying the need for signalization to manage traffic; and 

(iii) 175 (84%) are at-grade TBNs, implying that traffic congestion can be mitigated by 

improving at-grade intersections. 

Table 3.7:  Long-listed Intersection Bottlenecks by Type 

Int. Type >=LOC3 
Identified by 
MMDA/LGUs 

Non-signalized Signalized At-grade Segregated 

A x A 50 11 26 35 39 22 

A x B 58 17 30 45 66 9 

A x C 50 16 35 31 64 2 

B x B 6 1 1 6 6 1 

Subtotal 164 45 92 117 175 34 

Total 209 209 209 
Source: JPT 

Implementation  Possibility 
Short term/easy

Long term/difficult

highlow

High Priority 
for TM 

Improvement

Severity

New infrastructure

Severity of Queue Length  
Where queue length: 
01 Heavy: over 500m 
02 Moderate: over 300m to 500m 
03 Light: over 100m to 300m 
04 No Queue or <100m 

 

1 >=2 Direction = 03 

2 All Direction = 03 

3 =1 Direction = 02 

4 >=2 Direction = 02 

5 All Direction = 02 

6 >=1 Direction = 01 
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Figure 3.4 shows a map presenting the intersection, segment, and area TBNs.  

 
Source: JPT  

Figure 3.4:  Location of Segment Bottlenecks in Metro Manila 
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4 Causes and Factors of Traffic Congestion 

4.1 Congestion Causes according to MMDA and LGUs 

Based on the results of the questionnaire surveys conducted among MMDA and LGU CPTs, 

the major causes of traffic congestion, accounting for 35% for MMDA and 43% for LGUs 

are: PUJs stopping at intersections, non-compliance with driver rules, and illegal parking, 

as shown in Figure 4.1.   

The questionnaire survey results showed that there are some differences in the causes of 

traffic congestion as perceived by MMDA and LGU counterparts. The LGU counterparts did 

not consider excess demand as a top cause. This could be explained by the fact that their 

jurisdiction mainly covers local roads which have less traffic volume than major roads. 

Second, the causes identified by MMDA counterparts are attributed to the traffic bottlenecks 

on major roads, whereas those by LGU counterparts can be associated with traffic 

bottlenecks on local streets.   

 
1 “Others” include manual overriding of traffic signals, obstruction by illegal vendors, and poor signal phase timing. 

Source: Questionnaires conducted among MMDA and LGU CPTs. 

Figure 4.1:  Traffic Congestion Causes Identified by MMDA and LGUs 

4.2 Factors of Congestion 

Factors affecting traffic congestion in Metro Manila were grouped based on local traffic and 

physical characteristics, among other aspects, as shown in Table 4.1. Based on these, the 

JPT analyzed each bottleneck from the traffic engineering point of view. 

(a) Road Infrastructure: In particular, number of lanes (lack of number of lanes, 

insufficient road width); intersection layout (improper geometric layout, inadequate 

corner cutting, and improper location of road facilities [pavement markings]); road 

alignment (sharp curve, gradient change point [sag point], steep slope); 

tunnels/underpasses (entrance of underpasses). 
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(b) Traffic Control and Regulations: In particular, signal timing (inadequate traffic control 

with/without traffic signal); poor visibility of traffic signals; left-turning or oncoming 

vehicles (no left-turn lane, insufficient left-turn lane length, conflict between a left-turning 

car and an oncoming car); right-turning vehicles (right-turning vehicles blocking those 

going straight ahead, improper stop line position, improper channelization); and traffic 

signs (improper traffic sign or installation location). However, it should be noted that 

for intersections where traffic enforcers intervene, it is difficult to verify whether the 

signal control was appropriate relative to the traffic conditions since there are no records. 

Table 4.1:  Factors of Congestion  

Aspect Factor of Congestion 

 Road 
Infrastructure 

Number of Lanes 
Lack of number of lanes 

Insufficient road width 

Intersection Layout 

Wrong geometric intersection layout 

Inappropriate for center point of intersection 

Inadequate corner cutting  

Improper location of road facilities (road markings) 

Road Alignment 

Sharp curve 

Gradient change point (sag point) 

Steep slope 

Tunnels, Underpass Entrance of underpass 

Traffic Control 
and 

Regulation 
 

Signal Timing 

Inadequate traffic control (in case of no traffic signal) 

Inadequate traffic signal control (in case of with traffic signal) 

Poor visibility of traffic signal 

Left-turning or oncoming 
Vehicles 

No left-turn lane 

Insufficient left-turn lane length 

Conflict between a left-turning car and an oncoming car 

Right-turning Vehicles 

Right-turning vehicles blocking vehicles proceeding straight ahead 

Improper stop line position 

Improper channelization 

Traffic Sign Improper traffic sign or installation location 

Traffic 
Characteristic 

Conflict by Specific 
Traffic 

Speed reduction due to large vehicle 

Motorcycle is obstructed by other modes 

Bike is obstructed by other modes 

Inadequate pedestrian facilities 

Environment 
of Roadside 

and 
Intersection 

Railway Crossing Stopping traffic at railway crossing 

Bridge Section 

Difference in cross-sectional configuration between the bridge and 
general sections 

Concentration of traffic on bridges 

Traffic Flow from/to 
Roadside Land Use, 
Connecting Streets, etc. 

Traffic flow in/out at driveway along roadside shop 

Traffic flow in/out from intersections and narrow streets 

Traffic flow in/out from IC at expressway 

PUJ, PUB 

Speed reduction due to PUV stop 

Speed reduction due to PUJ stop 

Lane reduction with dedicated bus and priority lanes 

On-street Parking Obstruction of travel by on-street parking 

Traffic 
Demand 

Exceeding 
Capacity 

Excess traffic capacity at intersections 

Excess traffic capacity at non-intersections 

Concentrated Traffic 

Concentration of traffic at a specific time 

Concentration of traffic on roadside facilities at specific times and 
periods 

Concentration of traffic during specific periods during events or 
incidents 

Others 
Construction Work Lane blockage due to construction 

Clogging of Downstream Clogging with congestion  
Source: JPT. 
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(c) Traffic Characteristics: In particular, disturbance by specific traffic (reduced speed 

due to large vehicle, motorcycle obstructed by other modes, bike obstructed by other 

modes, inadequate pedestrian facilities). 

(d) Environment of Roadside and Intersections: In particular, railway crossing (stopping 

traffic at railway crossing); bridge section (difference in cross-sectional configuration 

between the bridge and approach sections, concentration of traffic on bridges); traffic 

flow from/to roadside land use, connecting streets, etc. (traffic flow in/out at driveway 

along roadside shop, traffic flow in/out from intersections and narrow streets, traffic flow 

in/out from IC at expressway); PUJs/PUBs (reduced speed due to PUV stop, lane 

reduction with dedicated bus and priority lanes); on-street parking (travel obstructed by 

on-street parking). 

(e) Traffic Demand: In particular, exceeding capacity (excess traffic demand at 

intersections, excess demand at non-intersections); concentrated traffic (at specific 

times, on roadside facilities at specific times and periods, or during events or incidents). 

(f) Others: In particular, construction work (lane blockage due to construction); clogging 

downstream. 

Based on traffic enforcers’ observation, data and information about congestion and its 

causes for each identified bottleneck were collated into datasheets, as shown in Table 4.2.  

The accuracy and consistency of these data were checked by photos taken at the site. 

Meanwhile, basic information, such as the intersection type (class, signalized, etc.), road 

inventory (number of lanes, road width, etc.), traffic count data from MMDA, and travel 

speed data from Waze, was also collected and shown in another datasheet (Table 4.3).  

Method of data collection for each Datasheet can be referred to Appendix. 

For this CTMP Project, the above-mentioned data helped in determining the intersection 

type of the bottlenecks and the countermeasures for each factor of congestion. For easy 

handling and access on demand, this intersection bottleneck database is stored in cloud 

servers. Microsoft Access can be used to navigate the database. Using a GIS application, 

the data can be visualized to see the location of intersection bottlenecks in Metro Manila. 

Together with other databases which the CTMP Project developed, analyzing the traffic 

situation in the metropolis and choosing TM measures have become more efficient and 

science-based (Figure 4.2). More detailed information can be referred to Technical Report 

08_Manual on Traffic Bottleneck Database.  
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Table 4.2:  Sample of Datasheet 2: Results of Site Observation 

 
Source: JPT 

  

Intersection Type

D1 D2 D3 D4 D5

1 3 1 1

2 3 2 2

3 1 3 3

1 2 1 1

2 3 2 2

1 1 1 1

1 2 1 1

1 1 1 1

1 2 1 1

1 3 1 1

1 1 1 1

1 2 1 1

1 3 1 1

1 1 1 1

1 2 1 1

1 1 1 1

1 2 1 1

1 3 1 1

1 1 1 1

1 2 1 1

1 3 1 1

1 1 1 1

1 2 2 1

1 1 3 1

1 1 1 1

1 2 2 1

1 3 1 1

1 1 1 1

1 2 1 1

1 1 1 1

1 2 1 1

Common Information

Lane reduction with dedicated bus and priority lanes

Time

Congestion Situation

D4 A. Arnaiz East 02 Moderate : over 300m to 500m Yes No

No

D1 Taft South 02 Moderate : over 300m to 500m Yes No

D2 Taft North 02 Moderate : over 300m to 500m No No

Conflict between a left-turning car and an oncoming straight car

Right-turning vehicles blocking vehicles proceeding straight

ahead

Improper stop line position

Improper channelization

Speed reduction due to large vehicle

Obstruction by motorcycles

Obstruction by bicycles

Wrong geometric intersection layout

Inadequate corner cutting

Improper location of road facilities (road markings)

Inadequate  of traffic signal control

Bad visibility of traffic signal

No left-turn lane

Insufficient left-turn lane length

Concentration of traffic on roadside facilities at specific times and

periods

Environment of

Roadside and

intersection

Railway Crossing

Obstruction by pedestrian

Stopping traffic at railway crossing

Traffic flow in/out from intersections and narrow streets

Traffic flow in/out from IC at expressway

Speed reduction due to PUV stop

Speed reduction due to PUJ stop

14.5476887, 120.9986181 Link to Map

Structure

Survey Date

MK01 Sheet No.

REGION 14 NCR CITY Makati

Administrator

(Main Road)
MMDA

Name of

Intersection
Taft Ave.-Antonio S. Arnaiz Ave.

Latitude / Longitude
(Center of Intersection)

CODE

1:STRONGLY AGREE, 2:AGREE, 3:DISAGREE

Factor item Checkpoint

 Road

infrastructure

Number of lanes

Intersection layout

Approach

 (toward)
Vehicle Queue Length

Spill over from

downstream

intersection

Spill over to upstream

intersection

D5

Checklist for Factor of Congestion (intersection)

Factor of Congestion

Lack of number of lanes

Insufficient road width

D3 A. Arnaiz West None Yes

Due to traffic accident, tenporaly congestion occurs

Driveway from roadside

shop

PUJ, PUV

On-street parking

Traffic Demand

Over capacity

Concentrated traffic

Traffic regulation

Signal timing

Right-turning or oncoming

vehicles

Left-turning vehicles

Traffic situation Large vehicle

Concentration of traffic during specific periods during events or

incidents

Construction Lane blockage due to construction

Clogging of downstreamOthers Clogging with congestion of  downstream

Free Comment

(if any)

Obstruction of travel by on-street parking

Excess traffic capacity at intersections

Excess traffic capacity at non-intersections

Concentration of traffic at specific time
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Table 4.3:  Sample of Datasheet 1: Basic Data and Information about Intersection TBNs 

 
Source: JPT 

REGION 14 NCR CITY Pasay

Intersection Type Structure

Signalization Pedestrian Signal

Station Name of Station

Dedicated

Left

Left-

Throug

h

Through
Dedicat

ed Right

Right-

Throug

h

Total
Dedicated

Left

Left-

Throug

h

Through
Dedicated

Right

Right

-

Throu

Total

1 0 4 0 1 6 3.5 0.0 14.0 0.0 3.5 21 03 DPWH Atlas

0 0 4 1 0 5 0.0 0.0 13.6 3.4 0.0 17 03 DPWH Atlas

3 3 7 03 DPWH Atlas

3 3 6.8 03 DPWH Atlas

03 DPWH Atlas

-

Class

Left Through Right Total

A 255 3,840     13       4,108  4,096     135 471 299 22.1%

A 0 3,163     332     3,495  3,627     81 527 279 24.5%

A 345 30          456     831     917        0 176 56 25.3%

A 12 25          134     171     203        0 44 6 24.6%

#DIV/0!

Class In/Out Km/h LOC

A 13.7 4

A 15.1 3

A 13.4 3

A 0.0 0 No Data

A 17.6 3

A 22.5 2

A 0.0 0 No Data

A 19.8 2

Outflow

D4 Taft South Inflow

D2_O EDSA East Outflow

Signal Data

Signal Phase Data URL

Inflow

CCTV Data URL

D4 Taft South

D4

D5_O Outflow

D1_O EDSA West Outflow

D4_O Taft South Outflow

D3_O Taft North

D3 Taft North Inflow

D5

D1 EDSA West Inflow

D2 EDSA East Inflow

Traffic Volume Survey Data (Excel) https://drive.google.com/drive/folders/1gOSUI9MSJXEtqUkKahlMjnaRxcj6Mt6f?usp=sharing

Travel Speed from Waze, LOC

Source 2019/ Weekday / Daily(6-20)/ Inflow

Approach

 (toward)

D2 EDSA East

D3 Taft North

D5

Taft South

PUJ PUV PUT%

D1 EDSA West

Peak Time From 08:00:00 AM To 09:00:00 AM

Approach

 (toward)

Peak Hour Traffic Volumes

(PCUs) Total

Volume
PUB

Traffic Volume

Date of Traffic Volume Survey Wednesday, March 06, 2019

D1 EDSA West

D2 EDSA East

D3 Taft North

Google Map (URL) https://www.google.com/maps/@14.5378334,121.0005801,19.03z?hl=ja

Layout (Inventory)

Approach

 (toward)

No. of Lane Road Width(m)

Data Source

D5

01 Yes Taft

Existing Layout (CAD) URL https://drive.google.com/drive/folders/10G2optZZAfXIiENqtECyVFYztzfYY5Z1?usp=sharing

Photo Date 2021/3/16 Time 8:00 URLhttps://drive.google.com/drive/folders/1vXTT281C1Ob2ajQuFtLbFhsS2bU-twAC?usp=sharing

Latitude / Longitude
(Center of Intersection)

14.5375177, 121.0007001

A x B 01 At-grade

01 Signalized 00 No

Common Information

CODE PY04 Sheet No.

Name of

Intersection
EDSA-Taft Ave.

Administrator

(Main Road)
MMDA
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Source: JPT 

Figure 4.2:  Conceptual Diagram of the Intersection Bottleneck Database 

  

Longlist
CODE Coordinates Datasheet1 Datasheet2

MK1 Inventory
Waze

D1~D4
SO result

MK2

MK3

MK4

CAD
Datasheet 1

Datasheet 2 (Site 
observation)

Map

Code MK1

Code MK2

Code MK3

Google Drive (Storage)

Traffic survey

Profile (PPT)

TBN Database (Access)

Visualization (QGIS)
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5 MANUAL ON IDENTIFYING TBNS USING WAZE TRAVEL 

SPEED DATA 

The first steps in identifying traffic bottlenecks involve defining the road classification, 

identifying target intersections (AxA, AxB, AxC, and BxB intersections), converting waze 

travel speed data from csv file to a map, and applying LOC criteria for intersection, segment, 

and area TBNs. MMDA and LGUs may also add problematic intersections based on their 

engineering judgement. 

 
Source: JPT 

Figure 5.1:  Workflow in Identifying Traffic Bottlenecks 
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5.1 Road Classification 

The JPT, MMDA, and LGU counterpart team defined each road class based on functionality. 

They specified which roads or establishments each road class connects. Moreover, 

expressways and major arterial roads provide the most mobility or ability to move, while 

local streets gives more access given more possible routes. 

Table 5.1:  Road Classification Description  

Road Classification  Definition Function 

Expressway and  
Major Arterials 

A 

 Controlled access or limited access road with 
access ramps, lane dividers, etc., for high-speed 
traffic. 

 Affect basic urban space & land use. 

 Backbone serving major traffic flow in Metro Manila 
such as R1-R10 and C1-C6, and those with the 
same function as an integrated network. 

 

Minor Arterials B 

 Provides access to international airports and ports 
and other major traffic-generating sources. 

 Articulate primary road network. 

 Provide major traffic flow with alternate routes. 

 Affect basic urban space & land use. 

Major Collectors C 

 Connect major traffic-generating sources of LGU 
to Primary roads. 

 Connect Barangay centers with LGU/City Hall. 

 Serve main traffic within LGUs. 

Minor Collectors D 

 Connect barangay with other barangays. 

 Road that connects main socio-economic activity 
facilities/areas such as schools, hospitals, 
markets, etc. for the residents in LGUs and 
provides good access to primary/secondary roads. 

 Roads that serve main traffic circulation within 
LGUs. 

Local Streets E 

 Roads that complete destination trips, connected 
to other roads but do not belong to the classes 
above. 

 Living roads that prioritize pedestrians. 

 Roads that mostly serve intra-barangay traffic, 
gated villages, etc. 

Source: JPT 

The following steps show how to edit the road classification of links from the Road Network 

database. 

(a) Open the attribute table and click “Dock Attribute Table” and “Move selection to top”. 

Mobility 

Acces
s 
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Source: JPT  

Figure 5.2:  Road Network Attribute Table 

(b) Select the links that need to be updated. 

(c) Select “NewRC” field and type the new value. 

- 1 = Expressway (black) 

- 2,3 = A (red) 

- 4 = B (blue) 

- 5 = C (green) 

- 9 = Others (grey) 

 
Source: JPT 

Figure 5.3:  Updating Road Links 

And click the “Update Selected”. The link will change it’s color depending on the new 

assigned class. 
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5.2 Waze Data Dashboard 

This section explains the elements found in the Waze Data Dashboard, as well as how to 

export network and space-time table data.   

(a) Access Metro Manila Waze Data dashboard by going to https://mmda-waze-jica-

dashboard-prod-zya4adr2eq-uc.a.run.app/.  

(b) Zoom the map such that whole Metro Manila can be seen in the screen. 

 
Source: JPT 

Figure 5.4:  Waze Data Dashboard 

(c) Set the filters to the left of the dashboard to change the results shown in the map or 

export the needed data.  

- Switch the analysis method to “Speed.” 

- Select 80kph. The colors shown in the map will correspond to the speed of the road 

link. 

- For some filters, you will be able to “Select All” the values. This will average the 

data called by the filter. You can also “Clear All” to unselect the values. 

For the traffic bottleneck identification in CTMP, ALL day of week, month, road type, 

and direction were selected for the year 2019. Time of day values were from 6:00 

am to 8:00 pm.  

Filtered values related to time of day, day of week, and month may be changed in 

future studies depending on the scope the strategies/plans to be implemented.  

- Road links with a likely cardinal direction of either East or North will show up under 

the “d0” filter, while those that are either West or South will show up under “d1.” 

https://mmda-waze-jica-dashboard-prod-zya4adr2eq-uc.a.run.app/
https://mmda-waze-jica-dashboard-prod-zya4adr2eq-uc.a.run.app/
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Source: JPT 

Figure 5.5:  Components of the Waze Data Dashboard  

(d) Show updated map or export needed data. 

- When needed filters are selected, click “Update Map” to apply the filters on the map. 

- Export road network attribute by clicking “Export data as CSV.” The attribute 

contains street name, average speed, road type, and well-known text (WKT) among 

others. WKT is important in plotting the links in a GIS software. 

- Export space-time for circumferential and radial roads by clicking “Export  

- Space Time Table Data as CSV.”  
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Source: JPT 

Figure 5.6:  Exporting Data from Waze Data  
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5.3 Creating Level of Congestion Map 

From the exported network data, the comma-separated values (CSV) file can be converted 

into a map. The following steps show how to compute for the level of congestion and to 

present the links in the map. 

(a) Paste the exported “Waze Network data” in the template provided. The template will 

determine road class based on the Level of Congestion (LOC) speed criteria set by the 

JICA project team. LOC of d1 and d0 shall be automatically computed by using the 

average speed (speed_d0, speed_d1) and road class (LOCClass) of each link.  

 
Source: JPT 

Figure 5.7:  Waze Data Converter 

(b) Save the file as “2019 Waze Travel Speed Data LOC Converter V1.csv”. 

 

 
Source: JPT 

Figure 5.8:  Save As File Type 

(c) Open “2019 Waze Travel Speed Data LOC Converter V1.csv” and Delete the Level of 

Congestion (LOC) speed criteria. 
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Source: JPT 

Figure 5.9:  Level of Congestion Speed Criteria 

(d) Open QGIS and create a new .qgz file.  

(e) A: Drag “OpenStreetMap” from Browser to Layers. B: Set Coordinate Reference 

System to “EPSG:4326”.  

 
Source: JPT 

Figure 5.10:  Coordinate Reference System 

(f) Right click OpenStreetMap (OSM) and click “Properties”. Set Grayscale to “By 

Lightness” and “Apply”. 
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Source: JPT 

Figure 5.11:  Map Set to Grayscale 

(g) Import Waze travel speed data by clicking on “Layer” -> “Add Layer” -> “Add Delimited 

Text Layer”. 

 
Source: JPT 

Figure 5.12:  Add Delimited Text Layer 
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(h) Load “2019 Waze Travel Speed Data LOC V1”. Geometry field will automatically detect 

the WKT column of the csv file. Select “Detect” for Geometry type. Press “Add”.   

 
Source: JPT 

Figure 5.13:  Load Delimited Text 

(i) In this updated map, the links are not yet categorized. 

 
Source: JPT 

Figure 5.14:  LOC Road Network 
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- Right click the layer. Click “Export.” Click “Save Features As” 

 
Source: JPT 

Figure 5.15:  Export LOC Map as Shape File 

- Set Format to “ESRI Shapefile” and save the shape file in a folder as “TBN 2019”. 

 
Source: JPT 

Figure 5.16:  LOC Map as Shape File 

(j) 10. Right click “TBN 2019” and click “Open Attribute Table”. Click “Dock Attribute Table”. 
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Source: JPT 

Figure 5.17:  LOC Map Attribute Table 

(k) A: Right click “TBN 2019” and click “Properties”. B: On the lower left, click “Style” and 

load “LOCClass”. Legends for different road classes will show on the map in different 

colors. 

 
Source: JPT 

Figure 5.18:  LOC Map Load Style 

(l) Links classified as EDSA and C5 should be sense-checked in the map because the 

formula in the excel file has limitations on detecting those links.  

Uncheck 1, 2, 3, and Exp from “TBN 2019” layer. Uncheck also the 2019 Waze Travel 

Speed Data LOC Converter V1. Links that does not belong to EDSA and C5 should be 

re-classified. 
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Source: JPT 

Figure 5.19:  Raw Data on C5 and EDSA links 

(m) A: Use “Select Features” and select links outside EDSA and C5. B: Select links. C: Click 

“Move Selection to Top”.  

 

 
Source: JPT 

Figure 5.20:  Cleaning EDSA and C5 Data 

(n) To change the LOCClass, selected links should be marked first. Label the links outside 

EDSA and C5 with a different number by selecting LOCClass. A: Type any number 

besides 1 to 3. For instance, “10”. B: And Click “Update Selected”.  
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Source: JPT 

Figure 5.21:  Reclassifying Links 

(o) Export TBN 2019 as .csv file and label it as “2019 Waze Travel Speed Data LOC 

Converter V2”.   

 
Source: JPT 

Figure 5.22: Exporting Cleaned LOC Map 

In this example, 2019 Waze Travel Speed Data LOC Converter V2 have links with 

“LOCClass=10”. These links were previously automatically classified as EDSA or C5 in 

the excel file and were labeled “10” in QGIS attribute table.  

These links should be re-classified as either 1, 2, 3, or Exp (based on the road type 

column).  
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Source: JPT 

Figure 5.23:  Attribute Table as CSV 

(p) Make a duplicate of “2019 Waze Travel Speed Data LOC Converter” and rename it to 

“2019 WTSD V2”. Use Vlookup function for LOCClass column from “2019 Waze Travel 

Speed Data LOCV2”.  

 
Source: JPT 

Figure 5.24:  VLOOKUP Formula 
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(q) Filter “LOCClass” = 10 and #N/A. 

 
Source: JPT 

Figure 5.25:  Filtering Reclassified Links 

(r) LOCClass = 10 should be changed to the default “LOCClass” value based on 

“roadType”. Copy the formula and select the cell along “roadType” (Column H).  

 
Source: JPT 

Figure 5.26:  Finalizing Road Class of Unclassified Links 

(s) A: Save the new version as .csv file. B: Delete the Level of Congestion (LOC) speed 

criteria and click save.  
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Source: JPT 

Figure 5.27:  Deleting LOC Criteria on CSV File 

(t) Load the new version of Waze Travel Speed Data. Click “Layer” -> “Add Layer” -> “Add 

Delimited Text Layer”. Select the .csv file. 

 
Source: JPT 

Figure 5.28:  Adding Delimited Text File of Sense Checked Data   

(u) Convert the map to .shp file. Right click on the Waze travel speed data and click “Export” 

-> “Save Feature as”. Set Format to “ESRI Shapefile” and save the shape file in a folder. 
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Source: JPT 

Figure 5.29:  Append to Layer 

(v) Select “Style” and load “LOCClass”. 

 
Source: JPT 

Figure 5.30: Load LOC Class Style 

Below is a map showing the road classification with different LOC criteria.  
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Source: JPT 

Figure 5.31:  Road Classification of the LOC Map 

(w) A: Duplicate the updated “TBN 2019” and rename as “TBN 2019 d0”. B: Load “LOC 

Map d0” style. 

 
Source: JPT 

Figure 5.32:  Load LOC Map d0 
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(x) A: Duplicate the updated “TBN 2019” and rename as “TBN 2019 d1”. B: Load “LOC 

Map d1” style. 

 
Source: JPT 

Figure 5.33:  Load TBN 2019 d1 Style 

(y) Filter “TBN 2019” duplicates based on desired values.  

 
Source: JPT 

Figure 5.34:  Road Network Under LOC 2 to 4 

(z) To be able to prioritize intersections along major roads, “LOCClass” should be further 

filtered into Class A and B. A: Open properties of “TBN 2019 d0” and select “Source”. 

B: Click “Query Builder”. C: Type “LOCClass” IN (‘1’,’2’,’C5’,’EDSA’) and press “OK”. 
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Source: JPT 

Figure 5.35:  Filtering Class A to Class B Road Links for d1 

- To be able to prioritize intersections along major roads, “LOCClass” should be 

further filtered into Class A and B. A: Open properties of “TBN 2019 d1” duplicates 

and select “Source”. B: Click “Query Builder”. C: Type “LOCClass” IN 

(‘1’,’2’,’C5’,’EDSA’) and press “OK”. 

 
Source: JPT 

Figure 5.36:  Filtering Class A to Class B Road Links for d0 
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Source: JPT 

Figure 5.37:  Class A and B Road Network Under LOC 2 to 4 
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5.4 Identification of Traffic Bottlenecks 

(1) Intersection  

The intersections with at least one inflow link categorized as LOC 3 to 4 are considered as 

“Traffic Bottlenecks (TBN).” Moreover, the 17 LGUs and MMDA determined intersection 

traffic bottlenecks by considering road classification and traffic conditions during peak hours. 

The following steps describes how to add an intersection based on the criteria mentioned 

above and how to add for other fields for the database. 

(a) Click “Layer” -> “Create Layer” -> “New Shape Layer.” 

 
Source: JPT 

Figure 5.38:  Creating an Intersection TBN Layer 

(b) A: Locate where you want to save the new shape layer by filling-out the file name. Save 

file name as “Intersection TBN” B: Add an filed or column by typing “Code” below “New 

Field”, select data type, and click “Add to Field List”. Repeat Step B and add “LGU” and 

“IntType”. 
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Source: JPT 

Figure 5.39:  Saving Point Shape File 

(c) A: Select “Intersection TBN”. B: Click “Toggle Editing” and then “Add Point Feature”. 

 
Source: JPT  

Figure 5.40:  Toggle Editing 

(d) A: Select intersection TBN on the map based on LOC criteria and LGU-MMDA 

recommendations. Then, input the LGU on the pop-up tab that will appear. B: Select 

“TBN 2019” and unselect “TBN 2019 d0 and TBN 2019 d1” to determine the “IntType”. 
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Source: JPT 

Figure 5.41:  Creating a Point 

(e) After creating all the points/intersections, name the codes by Intersection LGU (A-Z), 

then Intersection Type (AxA – BxB). Example: QC22. 

(f) Add other fields by right-clicking “Intersection TBN”, selecting “Attribute table”, clicking 

“New field”, typing the Name of the field or column and selecting the field Type. Save 

and click “Toggle editing mode” to lock the changes. 

 
Source: JPT 

Figure 5.42:  Intersection TBN Attribute Table 

The following are other fields to add after data collection: 

- Intersection Name (IntName), Text 

- LGU, Text 

- Intersection Type (IntType), Text (i.e. AxA, AxB, AxC, BxB) 
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- Structure, Text (i.e. At-grade/Segregated) 

- Number of Legs (Legs), Whole Number 

- X Coordinate (X), Decimal 

- Y Coordinate (Y), Decimal 

- Segment TBN, Whole Number 

- Area TBN, Text 

- PUV Stop, Whole Number (i.e. 1-Yes, 0-No) 

- Corridor, Text (e.g. C4, C5, R10) 

- Signal, Whole Number (i.e. 1-Yes, 0-No) 

- Signal Type, Whole Number  

 1 – At-grade, Unsignalized 

 2 – Segregated, Unsignalized 

 3 – At-grade, Signalized 

 4 – Segregated, Signalized 

- Crossing Conflict (Crossing), Whole Number  

- Merging (Crossing), Whole Number  

- Diverging (Crossing), Whole Number  

- AutoCAD, Whole Number (i.e. 1-Yes, 0-No) 

- Volume Count, Whole Number (i.e. 1-Yes, 0-No) 

The JPT has predetermined intersections (target intersections) under AxA, AxB, AxC, 

and BxB class. These points may be used as a base data for TBN maps. The “TBN” 

field requires the code of the intersection. Both points and fields may be added to this 

shape file. 

 
Source: JPT 

Figure 5.43:  Target Intersections 

(2) Segment 

A segment TBN is a road segment with at least one (1) intersection TBN that overlaps with 

links having LOC 3 to 4. The length of the segment is identified by the continues links with 
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LOC 3 to 4 on either side of the road. LOC 3 to 4 links disconnected by less than 100-meter 

distance shall still be considered as part of the segment. And, segment TBN should have a 

length equal to or more than 500 meters. 

 
Source: JPT 

Figure 5.44:  Segment TBN Criteria 

(a) Click “Layer” -> “Create Layer” -> “New Shape Layer.” 
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Source: JPT 

Figure 5.45:  Creating a Segment TBN Layer 

(b) A: Locate where you want to save the new shape layer by filling-out the “File Name”. B: 

Add an attribute or column by typing desired name, select data type, and click “Add to 

Field List”. 

 
Source: JPT 

Figure 5.46:  Saving Line Shape File 
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(c) A: Right click the Segment layer. B: Change the source of the layer to EPSG:3857 

 
Source: JPT 

Figure 5.47:  Setting Coordinate System of Segment TBN 

(d) A: Select “Segment TBN”. B: Click “Toggle Editing” and then “Add Line Feature”. 

 

 
Source: JPT 

Figure 5.48:  Toggle Editing 

(e) Trace the segment based on the given criteria and right-click. Fill-out necessary 

information. Add other fields by right-clicking “Segment”, selecting “Attribute table”, 

clicking “New field”, typing the Name of the field or column and selecting the field Type. 
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Source: JPT  

Figure 5.49:  Creating Line for Segment TBN 

(f) Open attribute table -> Click “Toggle editing mode” -> “Open filed calculator”. 

 
Source: JPT 

Figure 5.50:  Attribute Table of Segment TBN 

(g) A: Type “Length” beside Output field name -> Select “Decimal” from Output field type -

> Double click or type “$length” under “Geometry”. B: Open attribute table -> Click 

“Toggle editing mode” -> Double click on the “Length” field to sort from smallest to 

biggest -> Highlight the lengths less than 500 m -> Click “Delete” and save. 
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Source: JPT 

Figure 5.51:  Computing for Segment TBN Length 

(h) Name segments from North to South. Click “Dock Attribute Table” -> Click “Move 

selection to top” -> Select the Segment from North to South and type Segment number 

on “id” field. 

 
Source: JPT 

Figure 5.52:  Naming Segment TBNs 

Add other fields by right-clicking “Segment”, selecting “Attribute table”, clicking “New 

field”, typing the Name of the field or column and selecting the field Type. Save and 

click “Toggle editing mode” to lock the changes. 
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Other fields to be added include: 

- Road Name (RdName), Text 

- Road Class (RdClass), Text (i.e. A, B, C, Others) 

(i) To create a buffer, A: select “Segment”, B: click “Vector” -> “Geoprocessing Tools” -> 

“Buffer”. C: Select the layer “Segment TBN” and change “Distance = 50 meters” -> Go 

to “Buffered” -> Select “Save to File” -> Name it as Segment TBN -> Click “Run”. 

 
Source: JPT 

Figure 5.53:  Creating a Buffer for Segment TBN 

(j) hange the symbology of the buffer by opening the “Properties” and A: clicking “Style”. 

B: Select “Segment TBN”. 

 
Source: JPT 

Figure 5.54:  Load Segment TBN Style 

The map below shows the buffered segment TBNs (blue lines) that groups the 

intersection TBNs (yellow points).  



The Project for Comprehensive Traffic Management Plan for Metro Manila 
TECHNICAL REPORT NO. 4: IDENTIFICATION OF TRAFFIC BOTTLENECKS AND MONITORING 

5-33 

 
Source: JPT 

Figure 5.55:  Intersection and Segment TBNs with LOC Map 

(3) Area 

Area TBN further groups the segment and intersection TBNs for future project 

implementation. Saturated regions of the map with LOC 3 to 4 links, and intersection and 

segment TBNs comprise this TBN. It should be noted that relationship, distance, and local 

ordinances between intersection and segment TBNs should be considered in grouping 

them. The steps below show how to create a polygon for area TBNs. 

(a) A: Click “Layer” -> “Create Layer” -> “New Shape Layer.” B: Locate where you want to 

save the new shape layer by filling-out the “File Name”. C: Add an attribute or column 

by typing desired name, select data type, and click “Add to Field List”. 
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Source: JPT 

Figure 5.56:  Creating an Area Shape File 

(b) A: Select “Area”. B: Click “Toggle Editing” and then “Add Polygon Feature”. 

 
Source: JPT 

Figure 5.57:  Toggle Editing 

(c) Draw a polygon following the criteria for area and fill-out information in the pop-up box 

that will appear. Add other fields by right-clicking “Area”, selecting “Attribute table”, 

clicking “New field”, typing the Name of the field or column and selecting the field Type. 
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Source: JPT 

Figure 5.58: Adding Area TBN Data   
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VI.A. DATA COLLECTION

1. DATASHEET INFORMATION

REGION 14 NCR CITY Caloocan

Intersection Type Structure

Signalization Pedestrian Signal

Station Name of Station

Dedicat

ed Left

Left-

Through
Through

Dedicat

ed Right

Right-

Through
Total

Dedicat

ed Left

Left-

Through
Through

Dedicat

ed Right

Right-

Through
Total

2 1 3 0.0 0.0 6.1 0.0 3.1 9.2 01 CAD

3 3 6 9.5 0.0 0.0 9.5 0.0 18.9 01 CAD

3 3 0.0 0.0 8.9 0.0 0.0 8.9 01 CAD

1 3 1 5 3.3 0.0 10.0 0.0 3.3 16.7 01 CAD

01 CAD

-

Class

Left Through Right Total

1 0 1,113   39        1,152   1,152   6 246 2 22.0%

1 997 476      98        1,571   1,571   19 90 0 6.9%

1 0 2,307   38        2,345   2,345   3 278 1 12.0%

1 926 1,121   185      2,232   2,232   50 0 0 2.2%

Class In/Out Km/h LOC

1 12.9 3

1 25.4 0

1 19.4 2

1 26.6 0

1 21.2 1

1 26.5 0

1 13.5 3

1 27.0 0

Latitude / Longitude
(Center of Intersection)

14.6444224,120.9835574

A x A 01 At-grade

01 Signalized 00 Yes

Common Information

CODE CC05 Sheet No.

Name of

Intersection
5th Avenue-Rizal Avenue Extension

Administrator

(Main Road)
MMDA

01 Yes J. Teodor/5th Ave West

Existing Layout (CAD) URL https://drive.google.com/drive/folders/1baXd5YTbfWuc3kZjyOKQONGEOi4SvB3j?usp=sharing

Photo Date Time URL

Google Map (URL) https://www.google.com/maps?ll=14.64443,120.98349&z=19&t=h

Layout (Inventory)

Approach

 (toward)

No. of Lane Road Width(m)

Data Source

D5

Traffic Volume

Date of Traffic Volume Survey March 8, 2019

D1 Rizal Avenue Extension

D2 5th Avenue

D3 Rizal Avenue Extension

PUT%

D1 Rizal Avenue Extension

Peak Time From 07:00:00 AM To 08:00:00 AM

Approach

 (toward)

Peak Hour Traffic Volumes

(PCUs) Total 

Volume
PUB

D2 5th Avenue

D3 Rizal Avenue Extension

D5

5th Avenue

PUJ PUV

Traffic Volume Survey Data (Excel) https://drive.google.com/drive/u/3/folders/17iJdT15v55ERPMZTPANfvljgfotffmM_

Travel Speed from Waze, LOC

Source 2019/ Weekday / Daily(6-20)/ Inflow

Approach

 (toward)

Signal Data

Signal Phase Data URL

CCTV Data URL

D4 5th Avenue

D4

D5_O

D1_O Rizal Avenue Extension Outflow

D4_O 5th Avenue Outflow

D3_O Outflow

D4 5th Avenue Inflow

D2_O 5th Avenue Outflow

Rizal Avenue Extension

D3 Rizal Avenue Extension Inflow

D5

D1 Rizal Avenue Extension Inflow

D2 5th Avenue Inflow

Conflicts

Crossing Merging Diverging Total

16 8 8 32

Intersection Type

D1 D2 D3 D4 D5

1 1 1 1

1 1 1 1

1 3 1 3

3 3 1 3

3 3 3 3

3 3 3 3

3 3 3 3

1 1 1 1

3 3 3 3

3 3 3 3

1 1 1 1

3 2 1 3

1 3 1 1

1 3 1 1

1 1 1 1

3 3 3 3

3 3 3 3

3 3 3 3

3 3 3 3

3 3 3 3

3 3 3 3

1 3 1 3

3 3 3 3

1 1 1 1

1 1 1 1

1 1 1 1

1 3 1 1

3 3 3 1

3 3 3 3

1 1 1 1

1 1 1 1

Common Information

Administrator

(Main Road)
MMDA

Latitude / Longitude 14.644510, 120.983580 Link to Map https://www.google.com/maps/@14.6444111,120.9834158,3a,75y,42.65h,90t/data=!3m7!1e1!3m5!1sMkDnM8GTslE9LvckHaRKNg!2e0!6shttps:%2F%2Fstreetviewpixels-pa.googleapis.com%2Fv1%2Fthumbnail%3Fpanoid%3DMkDnM8GTslE9LvckHaRKNg%26cb_client%3Dmaps_sv.tactile.gps%26w%3D203%26h%3D100%26yaw%3D41.70677%26pitch%3D0%26thumbfov%3D100!7i13312!8i6656

CODE CC05 Sheet No.

REGION 14 NCR CITY Caloocan

Name of

Intersection
Rizal Avenue - 5th Avenue

Spill over from 

downstream 

intersection

Spill over to 

upstream 

intersection
D1 Rizal Ave South SB 03 Light : over 100m to 300m Yes No

01 At-grade

Survey Date March 19,2021 Time 4:20PM

Congestion Situation

Approach

 (toward)
Vehicle Queue Length

A x A Structure

No

D5

D2 5th Ave East WB 02 Moderate : over 300m to 500m Yes No

D3 Rizal Ave North SB 03 Light : over 100m to 300m Yes No

D4 5th Ave West EB 03 Light : over 100m to 300m Yes

Checklist for Factor of Congestion (intersection)

1:STRONGLY AGREE, 2:AGREE, 3:DISAGREE

Factor item Checkpoint Factor of Congestion

 Road 

infrastructure

Number of lanes
Lack of number of lanes

Insufficient road width

Intersection layout

Wrong geometric intersection layout

Inadequate corner cutting 

Improper location of road facilities (road markings)

Traffic 

regulation

Signal timing
Inadequate  of traffic signal control 

Bad visibility of traffic signal

Right-turning or 

oncoming vehicles

No left-turn lane

Insufficient left-turn lane length

Conflict between a left-turning car and an oncoming 

straight car

Left-turning vehicles

Right-turning vehicles blocking vehicles proceeding 

straight ahead

Improper stop line position

Improper channelization

Traffic situation Large vehicle

Speed reduction due to large vehicle

Obstruction by motorcycles

Obstruction by bicycles

Obstruction by pedestrian

Environment of 

Roadside and 

intersection

Railway Crossing Stopping traffic at railway crossing

Driveway from 

roadside shop

Traffic flow in/out from intersections and narrow streets

Traffic flow in/out from IC at expressway

PUJ, PUV

Speed reduction due to PUV stop

Speed reduction due to PUJ stop

Lane blockage due to construction

Clogging of Clogging with congestion of  downstream

Free Comment

(if any)

Lane reduction with dedicated bus and priority lanes

On-street parking Obstruction of travel by on-street parking

Traffic Demand

Over capacity
Excess traffic capacity at intersections

Excess traffic capacity at non-intersections

Concentrated traffic

Concentration of traffic at specific time

Concentration of traffic on roadside facilities at specific 

times and periods

Concentration of traffic during specific periods during 

events or incidents

Others

Construction

Datasheet 1 Datasheet 2 Map and Actual Photos

5
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1 USER’S GUIDE FOR SPREADSHEET CAPACITY ANALYSIS 

TEMPLATES 

1.1 Introduction 

Three (3) spreadsheet templates have been developed to facilitate capacity analyses of 

signalized and non-signalized intersections.  

This user's guide describes the basic operations of the templates concerning the 

initialization and data entry, and critical assumptions and analytical procedures from which 

the templates are constructed. The users are assumed to have an adequate working 

knowledge of personal computers and the Microsoft Excel spreadsheet program. It is also 

assumed that the users are sufficiently familiar with traffic engineering terminology and 

understand the theoretical bases of intersection capacity analysis to properly interpret the 

results. 

Because traffic, roadway, and control factors can sometimes produce a very complicated 

situation as far as capacity analysis is concerned, it is imperative that the user understands 

the basic assumptions and equations which have been used in constructing the templates. 

In particular, when an analysis involves shared left/through lanes and/or overlap phasing, 

an assessment should be made to determine if the methodology remains applicable. 

Sometimes, it may be necessary to alter the input data to "trick the system" into producing 

a better result. This cannot be done without a thorough understanding of the methodology. 

1.2 The Templates 

The first template, named “Intersection Turning Movement Survey – Conversion to TCUs,” 

is for converting intersection turning movement counts into Through Car Unit (TCU) which 

can then be input into the capacity analysis templates. 

The second template, named “Intersection Capacity Analysis - Planning Method,” is for 

evaluating future intersections, geometric improvements, and signal warrants, and in 

various planning and preliminary engineering studies which do not warrant a detailed 

analysis of signal operations. 

The third template, named “Intersection Capacity Analysis - Operations Method,” is for the 

detailed evaluation of intersection operations, particularly in evaluating the effectiveness of 

existing signal control, developing timing plans, comparing alternative phasing plans, and 

final intersection design. 

Both planning and operations methods require traffic volumes and intersection lane 

configuration as basic input. The main difference is that the user must specify signal 

phasing and timing in the operations method while such input data is not required for the 

planning method.    

  



The Project for Comprehensive Traffic Management Plan for Metro Manila 
TECHNICAL REPORT NO. 5: INTERSECTION CAPACITY ANALYSIS 

1-2 

1.3 A Few Words of Caution 

The templates are not perfect in the sense that there are unusual circumstances that would 

render the assumptions and the various parameters embedded in the templates inaccurate 

or invalid. The user should always review the input data and the results carefully before 

drawing conclusions. There is no substitute for sound engineering judgment, and one must 

take care not to fall into the “GIGO” trap1. 

A macro command to initialize the input data cells is incorporated into the templates. When 

the template is opened, a warning message regarding the use of macros may be displayed. 

Select “Enable Macros” to continue. Alternatively, macros can be disabled, and the template 

can be initialized manually when used for other intersections. 

The templates have been designed to avoid accidental alteration of the internal logic, and 

all cells are protected except the cells where data input is done by the user. If you try to 

input data into a protected cell, a warning message is displayed. Press the “Cancel” button 

in the dialogue box to terminate the operation. Do not remove the protection unless you 

know exactly what you are doing.  

Where input of a value data (including zero) is required, entering a label (including blank 

spaces) may result in errors in related cells. Therefore, one must not use the space bar to 

blank out a numerical entry; enter a zero (0) instead. 

  

                                                   
1  “GIGO” is an acronym used at IBM, back in the Stone Age of computers, and it stands for “Garbage In – Garbage 

Out” – in other words, the quality of the finished product will not be better than the quality of the input. 
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1.4 From Start to Finish 

The file names of the three templates are “TM_CONV_MMDA.xlsm,” 

“Capa_PL_MMDA.xlsm,” and “Capa_OP_MMDA.xlsm.”  The “xlsm” file format indicates 

that macro is embedded in the template and its use is explained below. These and any 

filled-in templates can be retrieved for editing or to start a new analysis. 

To start a new analysis from a previously filled-in template, press the “Shift,” “Ctrl” and “I” 

keys simultaneously. This will initialize all input data cells except for a few locations where 

default values are supplied but can still be changed by the user as they are not protected.  

The initialized template shows zero blanks in numerical cells and “XXXXX” in label cells. In 

addition, the initial texts in cells intended for inputs are colored blue to help distinguish which 

cells are intended for data entry. Note that time should be entered as a label and 

unnecessary zeroes may be erased as desired. For example, when left-turn movement is 

prohibited, a blank entry in the left-turn volume cell may be less ambiguous than a zero 

entry.  

Follow standard Excel procedures to print and store data sheets. Default print ranges and 

margins have been pre-defined but, again, they can be changed if necessary.  

Since data entry requires little effort, saving a datasheet to a file is not critical if a hard copy 

is retained, especially if one is kept in the traffic count folder. This would avoid the trouble 

of keeping track of the files. Otherwise, a file-naming scheme should be devised and 

followed to avoid confusion and make file identification and retrieval easier. As a suggestion, 

one might use “T” for the first digit to indicate that it is a turning movement survey file, “P” 

for the planning method, and “O” for the operations method. The next three digits could be 

the intersection number and the last four digits could be “_01A” to indicate the first count or 

analysis of 2022. The file name should appear on each spreadsheet at the upper right-hand 

corner following the title “FN:.”  

The workflow of intersection capacity analysis is shown in Figure 1.1. 
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Source: JPT 

Figure 1.1:  Intersection Capacity Analysis Process Flow 
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2 TURNING MOVEMENT SURVEY TEMPLATE 

This template is set up to process turning movement counts for a period on a separate 

worksheet. The upper part of the template identifies the location and the time period. The 

next section shows the through car units (TCU) used by the Template. The TCU converts 

the traffic count of different types of vehicles in different movement directions into equivalent 

car units. Below the TCU units are spaces for entering volume counts by classification and 

movement. Total vehicles and the equivalent TCUs for each movement are computed 

automatically. 

The turning movement diagrams at the bottom are plotted automatically using the total 

vehicle and TCU figures in the date entry table. 

 
Source: JPT 

Figure 2.1:  Intersection Turning Movement Survey – Conversion to TCUs 
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2.1 Street Orientation 

To avoid confusion, it is necessary to designate one of the two intersecting streets as north-

south street and the other one as an east-west street. The two street names should be 

entered separately in the designated cells. Also, each of the movements is numbered 1 to 

12 for uniformity. The movement numbers are shown in the table and the plots (Figure 2.1). 

After all the data are entered, the plots should be visually checked to spot any abnormalities. 

2.2 Conversion Factors 

Conversion factor converts the traffic count of different vehicle types and movement 

direction into the equivalent traffic volume of passenger cars through movement. There are 

9 vehicle types used by MMDA for classified traffic count surveys and three (3) factors for 

three (3) movements (left turn, through, and right turn). Thus, a total of 27 factors are 

defined.  

Large vehicles are less maneuverable than small vehicles and less efficient in terms of 

intersection operation. Passenger car equivalent converts the volume count of different 

vehicle types into that of a passenger car. The unit for the converted count is called the 

passenger car unit or PCU.  

Likewise, turning vehicles (left and right turns) normally take more time than through 

movement to pass through an intersection as they have to reduce the speed. Effective traffic 

count is thus higher than the actual count, or conversely, intersection capacity is reduced 

by turning vehicles. Through car equivalent adjusts the effective traffic volume into through 

car unit.  

The classification, applicable vehicle type, and default conversion factor are set in Table 

2.1. These factors are not protected and not initialized, and one can alter the factors, if 

necessary. It is recommended however to set the standard factors and apply these factors 

consistently. 

Table 2.1:  Vehicle Type Conversion Factor 

 Left turn Through Right turn 

1. Car 1.20 1.00 1.50 

2. Public utility jeepney (PUJ) 1.44 1.20 1.80 

3. UV Express (UV) 1.44 1.20 1.80 

4. Taxi 1.20 1.00 1.50 

5. Public Bus (PUB) 2.40 2.00 3.00 

6. Truck (Trk) 2.40 2.00 3.00 

7. Trailer (Tra) 3.00 2.50 3.75 

8. Motorcycle (MC) 0.60 0.50 0.75 

9. Tricycle 0.60 0.50 0.75 
Source: JPT 

2.3 Notes 

Three rows of the template following the heading “Notes:” are unprotected. They may be 

used to document any observations or comments which apply to the data. 
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3 CAPACITY ANALYSIS TEMPLATE – PLANNING METHOD 

This template is organized into four sections. The upper portion identifies the location, 

period of study, and assumed saturation flow rate. This is followed by a turning movement 

diagram and a lane configuration diagram. These are the main data entry sections. The 

next section is the analysis section which computes saturation flows and volume/saturation 

flow ratios (V/S), selects critical movements, and sums up the critical V/S values. All of 

these are done automatically. The last section, under the heading of “Notes:” allows the 

user to enter any remarks or comments which are appropriate or necessary to clarify either 

the input data or the results. 

 
Source: JPT 

Figure 3.1:  Intersection Capacity Analysis - Planning Method 
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3.1 Units 

Both the saturation flow rate and the volumes should normally be entered in units of TCU 

(through car unit) per hour. However, this is entirely up to the user as long as they are 

consistent. 

Lane widths must be in units of meters, with a maximum of two digits following the decimal 

point. 

3.2 Right-Turn on Red (RTOR) 

Where a right-turn on a red signal is permitted, a reduction in the right-turn volume should 

be considered. The user must estimate and enter these RTOR volumes in spaces provided 

in the volume diagram. In general, if there is a separate right-turn lane with adequate length, 

all of the right-turn vehicles may be treated as RTOR vehicles. On the other extreme where 

the right-turn volume is very small and there is no right-turn lane or right-turn island, no 

RTOR should be assumed.  

Another consideration to be made is the interference with the through traffic from the 

crossing road. If right-turning traffic has to merge with the through traffic of the crossing 

road, the former must give way to the through traffic resulting in the reduction of the volume 

that can make a right turn on red. On the other hand, if there is an exclusive lane for right-

turning traffic on the exit, there would be no interference with the through traffic on the 

crossing road. 

Usually, 10 to 20 percent of right-turn vehicles can be assumed to be RTOR. 

3.3 Saturation Flow Rate (S) 

A default value of 1950 TCU per 3.0 meters of pavement width is provided in the template 

based on TEC’s current practice. This can be modified to any value by the user. The 

program calculates the saturation ratio of lanes proportionally using this value. 
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3.4 Conflicting and Critical Movements 

The planning method of capacity analysis is formulated mainly based on “Conflicting 

Movements” and “Critical Movements.”  The concept is explained below: 

For a typical 4-legged intersection, there are twelve (12) movements (northbound left, 

northbound through, northbound right, etc.). Some of the movements can move 

concurrently (e.g. through movements on the same street) while some are conflicting (e.g. 

northbound through and southbound left-turn) and must move during different times of the 

signal cycle. Thus, signal timing is controlled by conflicting movements. 

 
Source: JPT 

Figure 3.2:  Movements and 
Conflicting Points 

 
NB through and SB left 

turn  
SB through and NB left 

turn 
Source: JPT 

Figure 3.3:  Conflicting Movements 

 

For any two-way street, there are mainly two sets of conflicting movements. Take a north-

south street, for example, the northbound through and the southbound left-turn form a set 

of conflicting movements (Figure 3.3) while the southbound through and northbound left-

turn form the other set. One of these two sets of conflicting movements is critical that it will 

require more green time than the other. In some cases, left-turn movement can become 

critical because left-turns from one direction also conflict with right-turns from the other 

direction. Nevertheless, the concept is the same. 

The amount of time required to process the critical conflicting movements in each cycle 

must be less than the cycle length if the intersection is to be free of congestion. The lower 

the G/C ratio of the critical conflicting movements, the better the intersection operation. 

Since the amount of green time required is proportional to the number of vehicles and 

inversely proportional to the saturation flow rate, the required G/C of all critical movements 

is proportional to the sum of V/S of all critical movements where S is the saturation flow 

rate. The sum of V/S of the critical conflicting movements is therefore a good indicator of 

an intersection's level of saturation and is defined as the saturation factor “Y”. 
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3.5 The "Y" Value 

The planning method begins by computing V/S for all movements. The next step is 

summing up the V/S values for all possible combinations of conflicting movements. Finally, 

the combination of conflicting movements which yields the highest total V/S value is chosen. 

Because the assumed saturation flow rate is achievable only under ideal conditions and 

because inter-green loss time and specific signal timing are not considered in the planning 

method, it is extremely important to understand that the computed “Y” value is not 

equivalent to volume/capacity ratio or even close to it. For a signal to operate without 

significant congestion, the “Y” value should be less than 0.75. Severe congestion should 

be expected if the “Y” value reaches 0.85. Typically, the results of planning analysis are 

interpreted qualitatively as follows: 

Table 3.1:  “Y” Value and Traffic Condition 

Range of Y Value Interpretation 

< 0.75 below capacity 

0.75 to 0.85 near capacity 

> 0.85 over capacity 
Source: JPT 

Comparing "Y" values in a quantitative way should be avoided especially for different 

locations and when the value differential is relatively small. For example, one should not 

quickly conclude that location “A” is better than location “B” because the “Y” values are 0.65 

and 0.70 respectively. Similarly, it may be erroneous to conclude that scheme “A” is better 

than scheme “B” because the former has a “Y” value of 0.76 while the latter has a “Y” value 

of 0.78. 

3.6 Shared Lane 

Saturation flow rates under shared lane conditions are extremely complicated as explained 

in Section 4 of this user's guide. For the planning method application, minimum V/S values 

are computed assuming the shared lane is actually used exclusively by the movement. 

When a movement uses exclusive lanes only, the minimum V/S is its actual V/S. When a 

shared lane is involved, a movement group (e.g. right/through as a group) V/S is computed. 

The group V/S is then used in lieu of the V/S for the specific movement. However, this is 

modified in two respects: 

(a) When the minimum V/S is greater than the group average, the minimum dictates the 

V/S value because the shared lane is, in reality, operating as an exclusive lane. When 

this is found to be the case, the user must modify the lane configuration, i.e., change 

the shared lane to the exclusive lane, and redo the analysis. 

(b) When right turns are made from a shared lane only, the V/S for the right turn is 

computed as if the shared lane is an exclusive right-turn lane. This is reasonably 

accurate as right-turn vehicles will accumulate in the shared lane while through 

vehicles will shy away from the lane. 
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3.7 Shared Left-Right Lane and Single-Lane Approach 

Where left and right-turns share a single-lane, either the left-turns or the right-turns must 

be treated as through traffic in order to fit into the template layout. If there is no opposing 

traffic, as at T intersections, either way, will work correctly. If there is opposing through traffic, 

the left-turns should be treated as through traffic. 

For a single-lane approach, the single lane should be treated as a shared right-through lane. 

The template will automatically adjust the through volume to include the left-turn traffic. 
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4 CAPACITY ANALYSIS TEMPLATE – OPERATIONS METHOD 

The organization of this template is similar to the planning method template, i.e., starting 

with a location and basic parameter section, followed by volume and lane configuration 

diagrams and an analysis section, and finally a “Notes” section. 

Location, time, volume, and lane configuration data are entered exactly the same as with 

the planning template, but additional input data are required. Cycle length and lost time are 

self-explanatory. The others are discussed below. 

 
Source: JPT 

Figure 4.1:  Intersection Capacity Analysis - Operations Method 
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4.1 Saturation Flow Rate 

Saturation flow rates of protected movements under the operations method vary depending 

on the lane width. A base rate of 530 TCUs per meter is used for a lane width of 4 meters 

or wider. For lane widths between 2.5 and 4 meters, the following equation is used: 

S = 1040 + 270 * W   where W is the lane width in meters. 

Thus, for a single 3-meter and double 3-meter lanes, the saturation flow rates are 1,850 

TCUs and 3,180 TCUs respectively. The reduction in per meter rate for wider pavement is 

necessary to reflect uneven lane distribution of vehicles.  

 
Source: JPT 

Figure 4.2:  Lane Width vs. Capacity 

Saturation flow rate and left-turn capacity under filtered left-turn conditions are described in 

Sections 4.8 and 4.9. 

4.2 Number of Phases 

Signal phases are indicated in the template as “A” …”F”. The number of phases is limited 

to 6 (A to F).  

4.3 Minimum G/C for Pedestrian 

Where a pedestrian crosswalk is provided, the Green/Cycle (G/C) ratio must be long 

enough to allow pedestrians to walk across the street safely. This G/C ratio is a function of 

cycle length and length of pedestrian crossing or width of the carriageway. Enter the 

pedestrian crossing length for each applicable phase following the heading “Width.”  The 

template computes the minimum G/C and transfers the data into the main analysis section 

under the heading “Min. G/C, G/C, L/C by Phase” for easy comparison with the actual G/C 

assigned to each phase. 

Minimum G/C for pedestrians is based on a constant “Walk” period of 7 seconds and a 

flashing “Don't Walk” period which is required to walk from the departing curb face to within 

1.5 meters of the curb face on the opposite side (It is normally assumed that pedestrians 

can finish the last 1.5 meters during the inter-green interval). A walking speed of 1.3 meters 

per second is assumed. 
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4.4 Filtering 

Where left-turn movement is made through filtering (i.e., without a protected phase), it must 

be indicated by a “Y” under the heading “Check Filtering (Y/N).”  The template is not 

designed to handle overlapping protective-permissive type phasing. In such cases, a 

conservative approach would be to ignore the permissive phase, i.e., assume left turns are 

made in the protected phase only. Based on the experience in the Philippines, the sequence 

of the protective-permissive left turn is not recommended as left-turning vehicles do not 

yield to opposing through traffic when the phase changes from protected to permissive. 

4.5 G/C and L/C 

The second and third rows of data cells under the headings of “Min. G/C, G/C ...” and “Ph.A 

Ph.B ...” display the actual Green/Cycle ratio assigned to each phase and the Lost 

Time/Cycle (L/C) ratio computed according to the previously specified lost time and cycle 

length. The assigned G/C (split) must be entered by the user. The total column is provided 

to ensure that the assigned G/C and the computed L/C total to one (1.00). 

The computed V/S (Volume/Saturation Flow) values under the heading “Movement V/S” 

provide clues as to what initial G/C values should be tested. To achieve a V/Cap 

(Volume/Capacity) ratio of less than one, G/C must be greater than V/S for any movement. 

By altering the G/C values (split) and the phase assignment, which is described in the next 

section, the user can find a combination that will produce the smallest V/Cap, a balanced 

V/Cap among the several movements, or the smallest average V/Cap for all movements. 

The ability to test different phasing and timing plans quickly is the main advantage of using 

the template; it does not automatically search for an optimum plan for the user. 

4.6 Phase Assigned 

The phasing plan is specified by the user under the heading “Phase Assignment” by 

entering a “1” in the appropriate cell of the movement-phase matrix. For example, a “1” in 

the upper-left corner cell indicates that a northbound left turn is assigned to Phase A and, 

conversely, a “0” or blank in this cell indicates that a northbound left-turn is not allowed in 

Phase A. 

4.7 Volume/Capacity Ratio 

To provide as much information to the user as possible, V/Cap is computed separately for 

each movement as well as for each direction and for the entire intersection. A timing plan 

which produces the lowest maximum V/Cap does not always produce the lowest average 

V/Cap. It is up to the user to decide which is the best measure to use in selecting the final 

design. For each movement, V/Cap is computed from: 

 

V/Cap = {V/S}/{G/C} 
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4.8 Capacity of Filtered Left-turn Movement 

The capacity of left-turn lanes under permissive left-turn conditions (i.e., filtering) is very 

difficult to estimate as many factors are involved, including volume level of opposing flow, 

the proportion of left-turning vehicles, amount of green time allocated to the movement, and 

lane configuration. 

While manual procedures using various charts and tables may produce more accurate 

results, the benefits are often offset by human errors due to misunderstanding and 

complexity of the procedures. To overcome the problem in conducting capacity analysis, a 

somewhat simplified methodology has been developed to allow automatic calculation in the 

spreadsheet implementation of capacity analysis for signalized intersections. 

(a) Capacity of Exclusive Left-turn Lane 

Maximum left-turn volumes vary depending on the volume of opposing traffic, G/C ratio, 

and the number of approach lanes that the left-turning vehicles must travel across. The 

relationship is depicted in graphic format in Figures 2.1 to 2.3 of “Manual for the Design and 

Layout of Traffic Signals in the Philippines.”  Although the relationship is non-linear, a linear 

approximation is considered satisfactory within typical ranges of volume and G/C ratio. This 

linear approximation can be expressed as: 

 M(l) = 150 + {1000-V(o)}/2 - {0.5-G/C}*800 - {60*{N(o)-1}} 

 where, M(l) = Maximum volume (capacity) of left-turn lane, 

  V(o) = Volume (Vehicle/Hour) of opposing traffic, 

  G/C = Green over Cycle ratio (split), and 

  N(o) = Number of lanes in the opposing direction. 

 The equation can be simplified as: 

 M(l) = 310 - V(o)/2 + G/C*800 - 60*N(o) 

Since pavement width is used throughout the spread-sheet application and M(l) has a 

minimum of 120 Vehicle/Hour, it is computed in the spreadsheet according to the following 

equation: 

MAX(120,310-V(o)/2+G/C*800-(60*W(o)/3))  or, 

MAX(120,310-V(o)/2+G/C*800-20*W(o)) 

where W(o) is the pavement width of the opposing direction and W(o)/3 is used to 

approximate the number of lanes. 

Note that M(l) is not the saturation flow rate; it is the capacity of the left-turn lane for the 

given G/C. For this special condition, the normal V/S calculation is not carried out for the 

left-turn movement. The left-turn capacity is obtained as discussed above and V/Cap ratio 

for the left-turn movement is determined directly instead of from {V/S}/{G/C}. 

(b) Capacity of Left-turns from Shared Lane 

Where left turns are made from a shared through/left lane, the left-turn capacity would be 

expected to be less than what is determined from the above equation due to interference 

of through traffic in the shared lane. However, this reduction should be negligible except 

when the adjacent exclusive through lanes are heavily congested and the opposing through 

traffic is light. Under such conditions, a simultaneous left/through phasing would most likely 

be better which will provide a protected left turn without reducing the capacity. Consequently, 
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the above formulation for the capacity of an exclusive left-turn lane is also applied to cases 

where left-turn filtering is made from a shared left-through lane. 

4.9 Saturation Flow Rate of Through Movement from Shared Lane 

Where left-turns are filtered and are made from a shared left-through lane, the shared lane 

can be used by through traffic for a portion of the available green time when the lane is not 

obstructed by left-turning vehicles. This unobstructed green time varies depending on the 

degree of saturation of the left-turn movement. The maximum volume of through traffic per 

hour of green time which could make use of the shared lane (Saturation flow rate of through 

movement) may be estimated from the following: 

Q(ts)= {1-V(l)/M(l)}*Q(t) 

 where,  Q(ts) =  Saturation flow rate of through traffic in the shared lane, 

  V(l) =  Volume of left-turns in the shared lane, 

  Q(t) =  Saturation flow rate of through traffic in exclusive through lane,  

and 

  M(l) is as determined above. 

4.10 Minimum and Group V/S  

As explained in the planning method application, it is necessary to compute and compare 

minimum and group V/S values to ensure that a shared lane is not functioning as an 

exclusive lane. However, in the cases involving left-turn filtering, computing group V/S 

values for the left-turn and the through movements is no longer necessary because the 

saturation flow rates already reflect the filtering condition as described in Sections 4.8 and 

4.9. 
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4.11 Optimum Cycle Length 

Optimum cycle length is calculated using Webster's equation. To obtain this value, the user 

must identify the critical movements by entering a “1” in the spaces provided. Currently, the 

maximum cycle length is set at 200 seconds. If the template shows 200 seconds as the 

optimum cycle length, it indicates that the intersection is saturated and cannot process all 

demands resulting in the queue. 

Webster’s equation is expressed as follows: 

𝐶𝑜 =  
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𝑆
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Where: 

Co = Optimum cycle length (sec) 

L = Sum of the lost time for all phases, usually taken as the sum of 

the inter-green periods (sec) 

V/S = Ratio of the design flow rate to the saturation flow rate for the 

critical movement in each phase 

If there is no overlap phasing, the critical movement for each phase is the movement that 

has the largest V/S value of all movements in that phase. If overlap phasing is used, 

however, the number of critical movements may be less than the number of phases and a 

movement with a large V/S value may not be critical if it can move in more than one phase. 

In the example below, movement A is not critical because the sum of the V/S values for 

movements B and C is greater than the sum for movements A and D. Furthermore, only 

movements B and C should be identified as critical even though there are three phases. 

Table 4.1:  Overlapping Phase 

Movement Phase V/S 

A 1+2 .35 

B 1 .15 

C 2+3 .32 

D 3 .10 
Source: JPT 

 
Source: JPT 

Figure 4.3:  Traffic Phases 

  

A A

B

C C

D

1 2 3


	FR TR03 Waze Data Dashboard and User Manual
	Cover
	List of Tables
	Table of Contents
	List of Figures
	Abbreviations
	1 OUTLINE OF WAZE TRAVEL SPEED DASHBOARD
	1.1 Introduction
	1.2 Concept of Travel Speed Dashboard
	1.3 Waze Data Specification
	1.4 Development of Pipeline for Aggregation
	1.5 Development of Travel Speed Dashboard
	1.6 Utilization of the Dashboard

	2 DESIGN AND TECHNICAL DOCUMENTATION
	2.1 Architecture of Platform
	2.2 Aggregation Method
	2.3 Data
	2.4 Dashboard
	2.5  Access Management
	2.6 Known Limitations

	3 USER MANUAL
	3.1 Instructions


	FR TR04 Identification of TBN and Monitoring
	Cover
	Table of Contents
	List of Tables
	List of Figures
	Abbreviations

	1 INTRODUCTION
	1.1 Objectives
	1.2 Overall Approach

	2 DEFINITION OF TRAFFIC CONGESTION AND TRAFFIC BOTTLENECKS
	2.1 Basic Traffic Engineering Knowledge of Traffic Congestion
	2.2 Definition of Common Criteria of Traffic Congestion and Bottlenecks
	2.3 Definition of Bottlenecks

	3 SHARED UNDERSTANDING OF TRAFFIC CONGESTION AND BOTTLENECKS
	3.1 Traffic Situation in Metro Manila
	3.2 Traffic Conditions in TBNs
	3.3 Classification of Traffic Bottlenecks

	4 Causes and Factors of Traffic Congestion
	4.1 Congestion Causes according to MMDA and LGUs
	4.2 Factors of Congestion

	5 MANUAL ON IDENTIFYING TBNS USING WAZE TRAVEL SPEED DATA
	5.1 Road Classification
	5.2 Waze Data Dashboard
	5.3 Creating Level of Congestion Map
	5.4 Identification of Traffic Bottlenecks

	APPENDIX
	Method of Data Collection and Longlist


	FR TR05 Intersection Capacity Analysis
	Cover
	Table of Contents
	List of Tables
	List of Figures
	Abbreviations

	1 USER’S GUIDE FOR SPREADSHEET CAPACITY ANALYSIS TEMPLATES
	1.1 Introduction
	1.2 The Templates
	1.3 A Few Words of Caution
	1.4 From Start to Finish

	2 TURNING MOVEMENT SURVEY TEMPLATE
	2.1 Street Orientation
	2.2 Conversion Factors
	2.3 Notes

	3 CAPACITY ANALYSIS TEMPLATE – PLANNING METHOD
	3.1 Units
	3.2 Right-Turn on Red (RTOR)
	3.3 Saturation Flow Rate (S)
	3.4 Conflicting and Critical Movements
	3.5 The "Y" Value
	3.6 Shared Lane
	3.7 Shared Left-Right Lane and Single-Lane Approach

	4 CAPACITY ANALYSIS TEMPLATE – OPERATIONS METHOD
	4.1 Saturation Flow Rate
	4.2 Number of Phases
	4.3 Minimum G/C for Pedestrian
	4.4 Filtering
	4.5 G/C and L/C
	4.6 Phase Assigned
	4.7 Volume/Capacity Ratio
	4.8 Capacity of Filtered Left-turn Movement
	4.9 Saturation Flow Rate of Through Movement from Shared Lane
	4.10 Minimum and Group V/S
	4.11 Optimum Cycle Length



